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ABSTRACT 
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Chapter 1 

 

Introduction To HRD 

What is Ham Radio Deluxe? 
Ham Radio Deluxe (HRD) is an integrated suite of software products for amateur radio.  HRD 
has been called "The Swiss Army Knife" for ham radio operators.  HRD is a software package 
that contains just about every utility any ham would ever use or need to automate his/her ham 
shack.  The package includes the five (5) major modules, listed below, along with many sub-
modules and utilities within each of the major modules. 
 

Rig Control     
Ham Radio Deluxe Rig Control provides rig control for over 100 supported radios through a 
richly featured full screen interface.  Not only can you control your radio from a local 
computer, by utilizing the built-in Remote Server option, you can control your HRD software 
from any remote location, as long as you have access to an active internet connection. 
 

Logbook     
Ham Radio Deluxe Logbook provides QSO logging, DX cluster connectivity, callsign lookup, 
and awards tracking.  Also included is with integration to LoTW, eQSL, Clublog, HRDlog.net 
and the QRZ.com Logbook).  TCP/IP connectivity is also provided for contesters for real-time 
logging of their contacts from the N1MM and TR4W directly into their HRD Logbook.  HRD 
Logbook supports both Microsoft Access and MySQL databases with strong features for backup 
and recovery.  
   

Digital Master (DM-780)    
Ham Radio Deluxe DM-780 provides most popular sound card digital modes with direct 
integration to Ham Radio Deluxe Logbook.  
 

Satellite Tracking     
Ham Radio Deluxe Satellite Tracking provides satellite operations with rig control and Google 
Earth integration.  
 

Rotator     
Ham Radio Deluxe Rotator provides control for many popular models of antenna rotators.  
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How It All Began  
In early 2003 Peter PH1PH and Simon HB9DRV talked about developing a simple program to 
control the soon to be released ICOM IC-703. Maybe it was the beer, maybe the desire to give 
something back to the radio amateur community, however on June 6th, 2003 the first line of 
code was written, Ham Radio Deluxe (Ham Radio Deluxe) was born. By late 2005 the number 
of registered users stood at 20,006 – quite an achievement in such a short time.  
   
In late 2011, Rick Ruhl (W4PC), Mike Carper (WA9PIE) and Randy Gawtry (KC0CBH) 
purchased the rights to the software and introduced the first commercial version of Ham Radio 
Deluxe in February, 2013 with the release of HRD Version 6.0.  
 

This Guide  
This guide was written to give the user general idea of how Ham Radio Deluxe is configured 
and operates.  There are many areas where you MUST refer to outside resources, such as your 
radio's operator's manual, or even a website, in order to configure or understand some 
sections.  We will make every effort to guide you in the right direction in areas where you will 
need assistance from outside resources.  
   
If you are not into reading software manuals, please, at least read the HRD V6.3 Quick Start 
Guide.  The Quick Start Guide is only 45 pages and will probably help you get HRD configured 
and running much faster than had you read nothing at all. 
 

How to purchase Ham Radio Deluxe? 
The Ham Radio Deluxe for purchase from the HRD Software LLC website 
(www.hrdsoftwarellc.com) or copy and paste  
 
http://www.hrdsoftwarellc.com/cgi-bin/store/commerce.cgi?pid=1  
   
Into your favorite web browser. The software is available for download or you have the option 
to purchase the software to be sent on a CD at an additional charge. HRD LC accepts major 
credit cards and PayPal.   
 
HRD can also be purchased, on CD, from various ham radio distributors located worldwide.  A 
list of distributors can be found on the HRD Software LLC website. 
 
 
 
 
 
 

http://www.hrdsoftwarellc.com/cgi-bin/store/commerce.cgi?pid=1
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Getting Started With Ham Radio Deluxe 
This chapter is devoted to explaining some of the policies, licensing, system requirements and 
other information of interest to you, as an end user, prior to downloading and installing the 
Ham Radio Deluxe software on your computer. 

 
If you have any questions or comments, please feel free to contact HRD Software LLC via e-
mail, phone or Support ticket.  
 

HRD Help Links  
Download Current version:  http://www.hrdsoftwarellc.com/setup.exe  
HRD V6.2 Manual:  http://www.hrdsoftwarellc.com/manual.pdf  
HRD Quick Start Guide:  
http://www.hrdsoftwarellc.com/HRD%20Quick%20Start%20Guide.pdf  
HRD Knowledge base:  http://tickets.hrdsoftwarellc.com/kb/index.php  
Website: http://www.hrdsoftwarellc.com  
Support:   http://tickets.hrdsoftwarellc.com/index.php.  
Forums: http://forums.hrdsoftwarellc.com  
YouTube Channel: http://www.youtube.com/hrdsoftware  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.hrdsoftwarellc.com/setup.exe
http://www.hrdsoftwarellc.com/manual.pdf
http://www.hrdsoftwarellc.com/HRD%20Quick%20Start%20Guide.pdf
http://tickets.hrdsoftwarellc.com/kb/index.php
http://www.hrdsoftwarellc.com/
http://tickets.hrdsoftwarellc.com/index.php
http://forums.hrdsoftwarellc.com/
http://www.youtube.com/hrdsoftware
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System Requirements  

Computer  
Ham Radio Deluxe is designed for Windows Vista and Windows 7, 8, 8.1 and 10, also Internet 
Explorer 6.0 (or higher) is required.   The HRD Software LLC support policy is we support the 
HRD software on Windows operating systems which are supported by Microsoft.  We will NOT 
provide any support for Windows XP or older even though HRD may possibly run on these 
older operating systems.  
 
There are no plans for a LINUX or Macintosh native version, Ham Radio Deluxe is known to 
run under Wine for LINUX and PC emulators for the Macintosh such as Parallels or Boot 
Camp.  HRD Software LLC provides LIMITED support for our software run in these 
environments.   
The suggested minimum computer specification is:  
 

Windows Vista, 32-Bit 
Processor Ham Radio 

Deluxe 
DM-780 
HRD 
Logbook 

2 Ghz 
2.3 Ghz 
2 Ghz 

Memory 
(Installed RAM) 

Ham Radio 
Deluxe 
DM-780 
HRD 
Logbook 

3 Gigabytes 
3 Gigabytes 
3 Gigabytes 

Hard Drive 
Storage 

Ham Radio 
Deluxe 
DM-780 
HRD 
Logbook 

20 Mb 
20 Mb 
50 Mb 

Color Display 1024 x 768 
minimum 

1280 x 1024 
preferred 

 
 

Windows 7, 8, 8.1 and 10, 32-bit 
Processor Ham Radio 

Deluxe 
DM-780 
HRD 
Logbook 

2.4 Ghz 
2.8 Ghz 
Dual Core 
2.4 Ghz 

Memory Ham Radio 4 Gigabytes 
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(Installed RAM) Deluxe 
DM-780 
HRD 
Logbook 

4 Gigabytes 
4 Gigabytes 

Hard Drive 
Storage 

Ham Radio 
Deluxe 
DM-780 
HRD 
Logbook 

20 Mb 
20 Mb 
50 Mb 

Color Display 1289 x 1024 
Minimum 

1920 x 1080 
Preferred 

   

64-Bit versions of the Windows operating system 

The requirements for any Windows 64-Bit system are the same as above, with the exception 
of the Memory (Installed RAM).  For optimum operation of Ham Radio Deluxe on a 64-
Bit Windows system we recommend having a minimum of 8 Gigabytes of RAM installed 
in the computer. 
 
Note: DM780 uses more resources than Ham Radio Deluxe when decoding many 
signals simultaneously. This is especially true if using SuperSweeper, therefore if 
you plan on using DM-780 we highly recommend the more ram installed the 
better. 
  

Internet Connection  
An active internet connection IS REQUIRED for the initial registration of Ham Radio Deluxe.  
Whether it's the 30-day Trial or the fully registered version, in order to validate the installation 
HRD needs to be able to connect to our License Server to record and validate your license.  
With the 30-day Trial, if no internet connection is present the trial period is limited to only 7-
days. 
 
Once activated HRD will run just fine without an internet connection, however, without the 
internet connection a lot of the functionality of HRD will be lost.  HRD required an active 
internet connection to access the DX Cluster nodes, upload and download to and from LoTW 
and eQSL.  These options are quite valuable if you are an Awards or DX chaser. 
 
Other items that would not be available without the internet connection would the automatic 
callsign lookup option using the online QRZ XML callsign lookup database which 
automatically populates data from QRZ into your logbook when you are in a QSO with a 
contact.   
 
Uploading to Club Log and HRDLog.net would also be unavailable without the internet 
connection. 
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Other Software  
In addition to the HRD software, we recommend having the following "FREE" programs on 
your computer for viewing demos, user documentation, YouTube videos and viewing many 
PDF files in our FAQ Database. 
 
1. Adobe Reader Version 9 or newer 
2. Adobe Flash Version 11 or newer. 
 
If you don't have the above programs, they can be downloaded from the Adobe website at: 
http://get.adobe.com/reader/ and http://get.adobe.com/flashplayer/  
 
Google Earth is an interesting FREE addition to your ham software collection and is directly 
accessable from Ham Radio Deluxe. 
 
Nova, a commercial software and Orbitron a FREE offering, both have the ability of being 
connected to the HRD Satellite Tracking software via a DDE server. 

Radio Interfacing  
You don't need a radio – Ham Radio Deluxe comes with built-in Dem-o-matic radio support 
(FT-450, FT-950, FT-2000, K2, Orion, TS-480, TS-570, TS-590 and TS-2000).  
   
Ham Radio Deluxe is designed to be used with one of the rigs listed above. Some modules, 
however, can be used without a connection to a rig. Logging will work but will not be as 
automated. Satellite tracking is still fun without a rig connected. In fact, there are only a few of 
the above listed rigs that "really" work fully with the satellite module. 
  
Some of the rigs listed above do not fully avail themselves to all the features of Ham Radio 
Deluxe. A number of the rigs do not provide Tx control easily. That is the limit of the rig, not 
Ham Radio Deluxe.  
   
For CAT control, all radios require some sort of SERIAL connection between the radio and the 
computer. Some of the newer model radios are equipped with a USB port on the back of the 
radio. All that is needed there is a USB cable from the radio to a USB port on the computer.  
Other radios have a standard DB9 serial port on the back which either connects directly to a 
DB9 Serial port connector on the back of the computer or through a Serial/USB converter to a 
USB connector the computer, while others connect from an ACC or DATA plug on the back of 
the radio through a Serial/USB converter to the computer.  
Many of these cables use the serial port. If you don't have a serial port all is not lost – USB 
serial converters are widely available. Also, there are options available that are USB based.  
One of these is HamLink USB from Timewave. This will allow rig control with most of the 
radios listed above.  
   
Note: If you need a Serial/USB converter be especially aware of the type of chips and drivers 
that are in the converter you choose. We recommend ONLY converters with FTDI or SI Labs 
chipsets and drivers. We have found these to preform exceptionally well with HRD and other 

http://get.adobe.com/reader/
http://get.adobe.com/flashplayer/
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radio related software.  
   
Beware of Prolific chipsets and drivers. There are many of these on the market 
which are counterfeit and the chipsets are of poor quality. The drivers are also 
poorly written and will not work properly with HRD, especially if trying to use 
them on a Windows 7 or 8 system.  
   
Some of the problems you may experience with these chipsets and drivers are system crashes, 
BSOD, program lock-ups, drivers won't install properly, comports disappear for no reason, just 
to name a few.  
   
If in doubt as to what you need to connect your radio to the computer running Ham Radio 
Deluxe, contact Timewave either through their website at www.time wave.com or phone 1-651-
489-5080, or, try RT Systems at www.RTSystems.com.   Either one can provide you with 
cables and connectors to meet your needs.  
    
The future trend in radio control and interfacing is the USB connection. More and more radios 
will only have USB ports and not Serial or Parallel ports. The USB port will even pass audio as 
rig control with a few of the radios.  
For the majority of the radios listed above, you will need to have a more robust interface if you 
need to send or receive audio. The audio recorder and PSK31 are two examples of this need.  
For more interfacing information visit the Downloads page at http://www.ham-radio-
deluxe.com/ for A basic guide to CAT and Audio interfacing which contains many designs for 
both CAT and audio interfaces for use with Ham Radio Deluxe.  
Check out the cable and interface solutions from:  
 

● Timewave  http://www.timewave.com  
● Tigertronics   http://www.tigertronics.com  
● RT Systems:  http://www.rtsystemsinc.com 
● ZLP Electronics  http://g4zlp.ham-radio.ch/  

 
For more information on the various types of computer interfaces, see the section entitled 
"Computer Interfacing" in this chapter. 
 

Supported Radios  
You don‟t need a radio – Ham Radio Deluxe comes with built-in Dem-o-matic radio support (FTDX-
5000, FTDX-9000, FT-450, FT-950, FT-2000, K2, Orion, TS-480, TS-570, TS-590 and TS-2000). 

Ham Radio Deluxe currently supports these 'real' radios: 

Alinco 
DX-77 SR-8 SR-9 

 

http://www.ham-radio-deluxe.com/
http://www.ham-radio-deluxe.com/
http://www.timewave.com/
http://www.tigertronics.com/
http://g4zlp.ham-radio.ch/
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DZ Company 
Sienna 

 

Elecraft 
K-2 K-3 KX-3 KX-3s 

 

FlexRadio 
PowerSDR SmartSDR 

 
 

Icom 

IC-7000 IC-703 IC-706 IC706 MkIIG IC-707 
IC-7100 IC-7100 V2 IC-718 IC-7200 IC-725 
IC-726 IC-728 IC-729 IC-7300 IC-735 
IC-736 IC-737 IC-738 IC-7400 IC-7410 
IC-746 IC-746 Pro IC-751a IC-751a (Piexx) IC-756 

IC-756 Pro IC-756 ProII IC-756 ProIII IC-7600 IC-7600 V2 
IC-761 IC-765 IC-7700 IC-7700 V2 IC-775 DSP 

IC-7800 IC-7800 V2 IC-781 IC-7850 IC-821h 
IC-9100 IC-910h IC-970h IC-R10 IC-R20 

IC-R7000 IC-R75 IC-R8500 IC-R9000 IC-R9500 
ID-31- ID-51-AE ID-5100 PCR-1000  

 

Kenwood 
R-5000 TS-140s TS-2000 TS-440s TS-450s 
TS-480 TS-50s TS-570 TS-590 TS-590SG 
TS-60s TS-680s TS-690s TS-790 TS-850 
TS-870 TS-940s TS-950 TS-990 TS-B2000 

 

Microtelcom 

Perseus 
 

SDR-Radio 
SDR-Radio 
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Ten-Tec 
TT-Argonaut TT-Eagle TT-Jupiter TT-Omni VI TT-Omni VII 

(Radio) 
TT-Omni VII 

(Remote) 
TT-Orion TT-RX-350   

 
 

Yaesu 
FT-100 FT-1000D FT-1000 MKV FT-600 FT-767GX 
FT-817 FT-817D FT-847 FT-857 FT-857D 
FT-897 FT-897D FT-840 FT-890 FT-900 
FT-920 FT-980 FT-990 FT-991 FTDX-9000 

FT-2000 FT-950 FT-450 FTDX-5000 FTDX-3000 
FTDX-1200     

 
 
Reminder: Many of the radios listed above have built-in CAT and Audio interfaces which can 
be accessed using ONLY a single USB connection from the radio to the computer.  These 
usually require downloading a driver from the radio manufacturer's website to install on the 
computer to access the radio properly.  Be sure to check with your radio owner's manual for 
information on how to connect the radio to the computer. 

Computer Interfacing  

Rig Control Interface  
The most important connections in a computerized ham shack are the ones between the rig 
and the computer.  HRD Support handles many support requests every day and find the issue 
leads to issues with the connections between the radio and the computer.  
   
Some of today's modern radios require ONLY a USB cable connected from the computer to the 
radio to provide BOTH rig control and the Audio Codec for the AFSK digital modes used in the 
HRD DM-780 software.  These radios normally require the installation of a DRIVER which can 
be downloaded from the radio manufacturer's website.  You can find the information on how 
your computer interfaces to a computer in your radio's user manual.  There will also be 
instructions on where and how to download drivers for your particular radio, if needed, in the 
radio manual.  
   
If your radio DOES NOT have an "All In One" type USB connection as described above, then 
you will need another solution to connect your radio to the computer.  
   
Inexpensive RS232, USB and audio cables are built from low quality materials and usually do 
not have proper shielding, so, they are susceptible to RFI in the shack.  The majority of the 
issues handled by HRD support, where the customer is having connectivity problems, strange 
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or intermittent behavior of the software or computer, even total computer system crashes can 
be traced to these cables.  
   
When setting up your CAT system, consider using only quality cables and plugs for ALL the 
connections between the rig and the computer.  Make sure ALL your equipment has good 
electrical and RF grounding, including the computer, and, DO NOT daisy-chain the equipment 
to a ground.  Have each piece of equipment grounded separately.   

 RS-232 Connection  
In general most radios require an RS-232 connection at the computer end. Most computers 
today do not come equipped with RS-232 ports.  If you are using a desktop computer and it has 
extra PCI or PCI Express  expansion slots on the motherboard,  it is to your advantage to 
purchase an RS-232 card and install it in your computer. They can be found on E-Bay for 
around $15.00, give or take.  You can also check with a local computer supply store or your 
computer manufacturer to see if they have these available.  Some Office Supply and Big Box 
stores like Best Buy, Staples or Office Max may carry these cards.  
 

 
RS-232 PCI Cards 

￼  

USB/Serial Connection  
For those who use laptops or computers where you can't install an RS-232 card you will have to 
have a good quality USB/Serial converter. Here's where things can get interesting. There are 
many of these converters available that are very inexpensive. Many of these inexpensive 
converters have poor quality chipsets and poorly written drivers. Due to the heavy load HRD 
places on the com ports many of these converters fail to function properly.  
 

 
 

HamLink USB from Timewave (www.timewave.com)  
 

http://www.timewave.com/
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All-In-One Interfaces 
There are many "All-In-One" interfaces on the market from various manufacturers.  This type 
of interface usually provides the convenience of only requiring one single connection to the 
computer, then connections from the interface to the radio that handles Rig Control, audio for 
the digital modes, true CW keying of the radio using the K1EL Winkeyer or some other chip 
that emulates the K1EL chip, and true RTTY FSK keying which many operators prefer because 
it allows you to take advantage of the filters in your radio while use of the RTTY AFSK mode 
does not.  Many of these devices have built-in soundcards, which is preferred over using the 
computer's soundcard.  The use of a second soundcard, whether it is a PCI card installed in one 
of the expansion slots of the computer, or an external soundcard, is highly recommended since 
it allows you to dedicate one card for your ham radio and digital communications while it 
leaves the other dedicated for sounds and audio directly from the Windows system so that one 
won't interfere with the other. 
 
The All-In-One interface devices are normally more expensive than any other type of 
interfacing, but, depending on how you operate, this type of interface is well worth looking 
into. 
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Getting Technical Support 
 
Our Technical Support Staff is always ready, willing and able to assist you with any problems 
you run into with the HRD software.  Note that we are responsible for the HRD SOFTWARE 
Only!! 
 

DO NOT E-MAIL THE SALES DEPARTMENT WITH SUPPORT 
QUESTIONS. 

 
E-mailing support questions to the sales department creates 3 unfavorable situations.  First, it 
takes our sales staff away from their specific job, which is handling e-mails and phone calls 
pertaining to the sale and shipping of the HRD software.  Secondly, there is a chance the e-mail 
may get set aside to be handled later, then it could fall through the cracks and not get handled 
at all, and three, it slows down the chances of you getting in contact directly with a technician 
who CAN help you since the sales person would probably, if he/she does answer your e-mail, 
will send you a response telling you to "open a support ticket" for our support staff to handle. 
 
Our support staff is available Monday through Friday from 6am to 5pm Eastern Time.  If you 
are trying to get support and because of your work schedule or something else that doesn't 
permit you to contact us during normal business hours, our staff will certainly be more than 
happy to set up an appointment after hours or even on a weekend in order to assist you with a 
problem you may be having with our software.  
 
The preferred method of contacting support is through our Support Ticket system.  This system 
is accessed from our website by clicking on the "Support" page from the main menu and select 
the Support Ticket option.  When a ticket is entered into the system, it is assigned a unique 
tracking number.  All communications between the technician and the customer should remain 
in this ticket thread.  That way we can track exactly what has been done and said about your 
issue and allows us to better troubleshoot your problem.  We ask that you DO NOT enter more 
than one ticket about the same issue.  This just confuses things trying to keep everything 
together and slows down the process of handling your support request. 
 
We do make every effort to handle each support ticket within 48 hours of it's receipt.  We do, 
however, sometimes get backed up and it might take us a little longer, especially during the 
summer when we are attending hamfests around the country.  There are many of these 
hamfests where the entire staff attends, in which case the support department and the sales 
department will be closed during the time we are gone.  Other times there may be only 1 or 2 
people available to handle support and sales, which does slow things down, so, please, if we 
don't get right back to you, be patient.  We will get with you just as soon as possible and will 
spend as much time as necessary to make every attempt to resolve your issue. 
 
When you do contact support, whether it is by support ticket or on the phone, we are going to 
ask some questions which we need accurate answers for in order to be able to troubleshoot 
your problem.  Below is a list of the most common things we ask for.  Some of the items are 
required fields on all support tickets.  Others are things that you need to provide either in the 
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text portion of a support ticket, in your e-mail or have available so you can give us the 
information on the phone. 

● Your NAME  
● Your Callsign  (required for all support requests)  
● Your Radio  
● Your Interface  (How the radio is connected to the computer)  
● Your HRD Version  (In HRD click on HELP > ABOUT)  
● Your Windows Version 
● How much RAM is installed in your computer  
● A detailed description of the problem your seeing.  Please don't just say "I 

can't get my radio to connect".  That doesn't really give us any information 
to use to troubleshoot.  Tell us if you are getting an "error" screen and if you 
are, what "error" are you getting?  What EXACTLY are you doing when the 
problem occurs?   Small things that you may not feel important may give us 
clues as to what the problem is and how to resolve it.  

● Include screenshots of the issue, if possible. 
  

If you call on the phone, there are times when we may ask if we may remote into your 
computer to troubleshoot the problem.  We use a program called "Teamviewer" for all of our 
remote connections.  Since Teamviewer is a FREE FOR PERSONAL USE program, many 
people already have the software on their computer, however, you may not have a version that 
is compatible with the commercial version we use.  If you feel we may need to do a remote into 
your computer to help you, it would help and save a lot of time if you could download and save 
on your computer a special version of Teamviewer that we have our clients use.  It is 
Teamviewer QS, a small executable file that does NOT install Teamviewer on your computer 
but rather is just an executable that allows us to connect to your computer.  This version can be 
downloaded by going to www.hrdsoftwarellc.com and click on "Support" at the top of the 
home page.  On the Support page, scroll down until you see the "Teamviewer" icon, 
download and save the Teamviewer QS program on your computer.  Once you have it saved on 
your computer you can easily access it if asked to do so during a phone support call.  You could 
also download the Teamviewer QS program by clicking on the link in the HRD Help Links at 
the bottom of this section. 
 
Our technicians ARE NOT teachers.  They are not there to teach you to use your radio.  They do 
not teach you to use your interface, your computer or any other hardware in your shack.  If you 
contact our support team with a problem and it's determined the issue is NOT with the HRD 
software, you will be advised on the next step you should take to get help.  
   
We do ask that you at least make an attempt at using the "Self-Help" systems that are available 
for all registered and trial HRD users.  We have the Knowledge Database in our support 
ticket system which can answer many of the commonly asked questions without having to 
directly contact a technician.   To access the Knowledge Base, you can open the main HRD 
website page and click on the "Help (FAQ)" option at the very top of the page, or, you can use 
the link listed below in the "HRD Help Links". Other self-help options are the HRD Forums, 
the HRD Software Channel on YouTube and many, many specialized Yahoo Groups for radios, 
interfaces, software and just about anything else you may need some assistance with. 
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If you are unable to find the answer to your question through the above options, then feel free 
to call or open a "Support Ticket" and one of our technicians will be more than happy to assist 
you.  
   
For those using the 30-Day Trial version, we remind you that you do have the full support of 
our highly qualified Technical Support Staff should you run into any problems installing or 
configuring the HRD software.  If you do have any technical problems while installing or 
configuring HRD, please, DO NOT CONTACT THE SALES DEPARTMENT.  They will NOT be 
able to help you.  Please contact the support department directly either by phone or by entering 
a support ticket from the "Support" page on our website at www.hrdsoftwarellc.com or 
www.ham-radio-deluxe.com.  The support phone numbers and other helpful links are as 
follows.  
   
HRD Help Links  
Download Current version:  http://www.hrdsoftwarellc.com/setup.exe  
HRD V6.2 Manual:  http://www.hrdsoftwarellc.com/manual.pdf  
HRD Knowledge base:  http://tickets.hrdsoftwarellc.com/kb/index.php  
Website: http://www.hrdsoftwarellc.com  
Support: http://tickets.hrdsoftwarellc.com  
Forums: http://forums.hrdsoftwarellc.com  
YouTube Channel: http://www.youtube.com/hrdsoftware  
Teamviewer QS:  
http://download.teamviewer.com/download/version_10x/TeamViewerQS.exe 
 
Support Hours:  Monday - Friday 9am to 6pm EST.  
Phone USA: 813-434-4650  
UK/Europe: +44-1924-601057  
 

Note: Support hours are subject to change contingent on the number of 
technicians available, hamfest and holiday schedules, vacations and/or other 

unforeseen events. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.hrdsoftwarellc.com/
http://www.ham-radio-deluxe.com/
http://www.hrdsoftwarellc.com/setup.exe
http://www.hrdsoftwarellc.com/manual.pdf
http://tickets.hrdsoftwarellc.com/kb/index.php
http://www.hrdsoftwarellc.com/
http://tickets.hrdsoftwarellc.com/
http://forums.hrdsoftwarellc.com/
http://www.youtube.com/hrdsoftware
http://download.teamviewer.com/download/version_10x/TeamViewerQS.exe


HRD Rig Control V6.3          Copyright © 2016 HRD Software LLC         

 

22 

 

License Agreement 
  
IMPORTANT: Before commencing using this Product, carefully read the following terms and 
conditions which have been accepted by your company ("Licensee"). 
 
1. DISTRIBUTION. This Product may be distributed by HRD Software, LLC or its agents for 
use by Radio Amateurs. It may not be sold. The maximum charge allowed for the distribution 
medium is $0.  
 
2. GRANT OF LICENSE. HRD Software, LLC hereby grants to Licensee ("You") and You accept 
a nonexclusive license ("License") to use this Product delivered pursuant and subject to this 
Agreement. 
 
You agree that You will not assign, sublicense or otherwise transfer your right under this 
Agreement without the prior written consent of HRD Software, LLC. The purchased key cannot 
be transferred since it is based on YOUR callsign. 
 
3. TERM. This Agreement is effective from the day HRD Software, LLC grants this License, and 
continues until terminated. HRD Software, LLC may terminate this License if You fail to 
comply with any term or condition of this Agreement. You agree upon such termination to 
destroy this Product together with all copies in any form. 
 
4. TITLE; CONFIDENTIALITY. You acknowledge that title and full ownership, trade secrets, 
copyright, patent rights to this Product furnished under this Agreement remain with HRD 
Software, LLC, whether or not any portion thereof is or may be validly copyrighted or patented. 
By accepting this License, You are only granted limited license rights to use the Product. You 
agree to treat the Product as HRD Software, LLC's proprietary information. 
 
5. LIMITED USE: Ham Radio Deluxe - You require a license from HRD Software, LLC. You 
may not modify the product or merge the product into any other computer programs. You may 
not reverse assemble or decompile the program, in whole or in part. 
 
Other Programs (PSK31 Deluxe, Digital Master 780, Mapper, HRD Logbook, Rotor). 
 
6. LIMITED WARRANTY. HRD Software, LLC warrants that he has the authority to grant this 
License to You. 
 
THERE ARE NO EXPRESS OR IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED 
TO IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. 
 
7. LIMITATION OF LIABILITY. HRD Software, LLC shall not be liable to You or any other 
party for any amount whatsoever. 
 
In no case is HRD Software, LLC responsible for any indirect, incidental, or consequential 
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damages, such as, but not limited to, loss of anticipated profits or benefits. 
 
8. We reserve the right to refuse service and disable a customer’s key at any time for any reason 
 
9. GOVERNING LAW. This Agreement is to be governed by and interpreted in accordance with 
the laws of United States of America and the state of FL. 
 
The place of jurisdiction is the place where HRD Software, LLC resides. 
 
HRD Software, LLC is however also free to institute legal proceedings at the place where You 
are situated. 
 
If any provision of this Agreement shall be declared invalid or unenforceable, such provision 
shall be deemed to be deleted, and it shall not affect the validity of any other term or provision 
of this Agreement. 
 
10. TERMS.  ALL Term in this Agrement are subject to change including but not limited to 
program, support, open source and anything else not covered in this Agreement. 
 
11. WHOLE AGREEMENT. This Agreement is the complete and exclusive statement of the 
Agreement between us; and supersedes any proposed or prior agreement, oral or written, and 
any other communications between us relating to this specific granted license and the related 
obligations; and may be modified or supplemented only by a document signed by both parties 
to this Agreement. 
 
  
NOTICE: HRD Software LLC reserves the right to change or amend this policy at 
any time without prior notice. 
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Software Support & Maint. Agreement 
Included with your initial purchase of the HRD software package is a NON-Mandatory 
Software Support & Maintenance Agreement.  What this means to you is, during the 
first year after your purchase, you can download each and every updated release of HRD and 
receive all NEW Features, bug fixes and additional databases, such as the Country List/Unique 
Callsign Database, at NO ADDITIONAL CHARGE.  This is all covered under your initial 
purchase of the software. 
 
After the first year, you will receive a notice from your License Manager that your key has 
EXPIRED.  This does NOT mean that your software license has expired.  Your license for the 
software is a LIFETIME license and will never expire. This means the Software Support and 
Maintenance Agreement has expired. 
 
What this means is you can still download all updated releases of the HRD software to take 
advantage of BUG FIXES, for as long as you own the software, however, once the Software 
Support and Maintenance Agreement has expired, you will no longer be able to access any 
NEW Features added to the software after the expiration date of your agreement.   
 
A few features, such as the automatic updating of the Country List and the Unique Callsign 
Database are an exception to the above agreement. These databases requires constant updating 
by our development team and therefore do auto-updating feature for these databases will end 
at the expiration of your Support and Software Maintenance Agreement, and will only be 
reactivated on renewal.  
 
Renewal of your Software Support and Maintenance Agreement is HRD's way of maintaining 
cash flow in order to provide continued active development on the software.  It also helps pay 
utilities, cost of running the website, sales and support staff salaries and other operating costs.   
The fee for this renewal is 1/2 (50%) of the effective retail price.  Your support through 
renewals insures continued development and support for Ham Radio Deluxe.  Please, support 
us so we can support YOU! 
 
 
NOTICE: HRD Software LLC reserves the right to change or amend this policy at 
any time without prior notice. 
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30-Day Trial Policy 
 
Due to much abuse, HRD Software LLC has had to re-vamp our 30-day trial policy.  This policy 
will be strictly enforced. 
 
When a version of HRD is loaded on your computer and is activated in the "Trial" mode, 
without entering an activation key, HRD automatically connects to the HRD License Server 
and creates a record containing the callsign you entered and the date.  The server then 
calculates the 30 day expiration date and records that in the record.  This provides our support 
staff with the information needed to provide trial users with full support during the trial 
period.  If the computer that HRD is being installed on has an active internet connection, and 
the connection to the HRD License Server is successful, a 30-day trial will be granted.  It there 
is NO active internet connection, only a 7-day trial will be granted. 
 
There is one other restriction to the Trial version, at this time, and we are considering changing 
this at some point in the future.  The trial version can only be installed and run on 
ONE computer.  The drawback to this is you will not be able to run the trial version on more 
than one computer to test or evaluate the HRD Remote Server options.  Other than this one 
drawback, the trial version is not crippled in any way. 
 
HRD Software LLC will allow only ONE 30-DAY TRIAL for each MAJOR software release.  A 
Major Release is one which has a version number that begins with "V6.2, V6.3, V6.4," etc. 
 
If for example, you downloaded the 30-day trial for V6.3.0.400, you could test and evaluate 
that version for 30 days, however, since we do update the software for bug fixes on a regular 
basis, after your 30 day trial, you would NOT be allowed to download and have a 30-Day trial 
for V6.3.0.500, as that would still be considered the same major release you previously used.  
but a new build was released for maintenance purposes. 
 
If you have already installed and run the 30-day trial using a major release, any additional 
attempts to install and run the same major version will result in the software NOT activating 
on your computer.  The software will REFUSE to run. 
 
If for some unusual reason or circumstance, you were not able to complete the full 30-day 
evaluation, you would be able to request a 10 day extension to your test and evaluate your 
CURRENT trial version. 
 
The request for the extension must be submitted to the Sales or Support 
department by entering a Support Ticket ONLY.  The extension will be granted at 
the discretion of HRD Management ONLY. 
 
NOTICE: HRD Software LLC reserves the right to change or amend this policy at 
any time without prior notice. 
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HRD Activation Key Policy  
   
An Activation Key is required for each callsign for each user of the Ham Radio Deluxe 
software.  The original purchaser of HRD receives his or her activation key when they make the 
purchase.  There are situations where more than one activation key is required and HRD 
Software LLC will provide these keys at no additional cost to the original purchaser.  
   
Due to abuse by some who request additional activation keys for the HRD software, we have 
adopted, and will enforce, the following rules for issuing additional keys for the Ham Radio 
Deluxe software.  If the qualifications for an additional key are met, HRD Software LLC will 
gladly issue an additional key at, no extra charge, to the registered owner of the Ham Radio 
Deluxe software.  
   
Additional key requests MUST be made in writing and e-mailed to: sales@hrdsoftwarellc.com.  
The e-mail must contain the Primary HRD License holder's callsign as well as the callsign and 
any required documentation for the key being requested.   
   
In the event there is more than one ham in the primary HRD license holder's household, provisions 
have been made in the software so that each operator can run HRD having their own unique setup.  
This is accomplished by creating a separate Windows User Account for each ham using the shared 
station equipment and computer.  Each Windows user will enter their unique activation key into 
HRD and this creates a separate HRD experience for each user on a shared computer.  This key is 
directly linked to, and is subject to, the same rules and limitations as that of the Primary HRD 
License Holder. 
   
DO NOT open a support ticket requesting an additional activation key.  This will 
only slow down the process since the Tech Support department does not have access to all 
records that may be required to verify the request and generate a key.  
   
NOTE:  HRD Software LLC verifies all callsigns for validity.  For operators in the 
United States, we use the FCC ULS for verification.  If you hold a foreign callsign, 
and we cannot verify it's validity in any other way, you may be required to submit 
a scanned copy of the Amateur Radio License Certificate,  for the callsign,  for 
which a key is being requested.  
   
The following are the rules governing the issuing of Activation Keys.  These rules will be strictly 
enforced by HRD Software LLC with absolutely NO EXCEPTIONS.   

Primary HRD License Holder  
HRD Software LLC provides an Activation Key for the person who purchases the Ham Radio 
Deluxe software.  This key is based on the purchaser's legal amateur radio callsign and cannot 
be transferred to or used by any other operator.  If the registered owner of the HRD software 
possesses more than one amateur radio license, an additional key may be requested, however 
we may request documentation to verify the additional call belongs to the Primary HRD 
License Holder.  
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Family Member Calls  
HRD Software LLC will provide additional keys for immediate family members (spouse and/or 
children under the age of 18), who live in the Primary HRD License Holder's home.  The 
physical home address for the callsign being requested must match that of the Primary HRD 
License Holder's address.  
   

Inactive Calls  
If the callsign for which you are requesting a key for shows up as inactive or expired, we will 
NOT issue an additional key.  In other words, if you held a previous callsign, at some point in 
time,  and we cannot verify it as an active call or you cannot provide a valid License Certificate 
showing it as being an active call, we will NOT issue a key.  
   

Modified Calls  
Callsigns with prefixes or suffixes (modifiers) ARE NOT SUPPORTED by the HRD Software 
Licensing system. If you are using a call such as F4/KB3NPH or KB3NPH/M, both considered 
MODIFIED callsigns.  Modified calls are usually used on a temporary basis when you are 
operating outside of area or country (K6/KB3NPH or F4/KB3NPH), or if you are operating as a 
mobile station (/M), maritime mobile (/MM), aeronautical mobile (/AM), etc.,  and we cannot 
issue keys for these calls.  Callsigns like this are normally NOT ISSUED by the Amateur Radio 
Licensing Agency in the country of origin.  If you are using a modified call on a temporary 
basis, you could set up a "New Location" or "Guest" profile in the "My Station" profiles located 
in the HRD Logbook module,  (Tools > Configure > My Station"). If operating using Digital 
Master 780, calls like this could be typed directly into the macros instead of using the <tags> 
that would normally be used to insert your callsign into a macro.  

Club Calls  
Keys for Club Callsigns cannot be issued to individual club members.  An additional key may be 
issued ONLY to the club trustees whose name appears on the license.  If a trustee is requesting 
an additional key, they may be required to send a scanned copy of the club's license certificate 
which indicates them as the trustee for that call.  

QSL Managers  
We have received a few requests from QSL Managers who use the HRD software for their 
personal use and show an interest in receiving additional keys for callsign QSL management.  
We understand how this could assist these QSL managers in keeping track of those they 
manage, however, at this time we cannot provide additional keys for this purpose.  At some 
point in the future, we may be able to provide feature, but for now, please don't ask.  We don't 
like to say "NO" to anyone.  
   
NOTICE: HRD Software LLC reserves the right to change or amend this policy at 
any time without prior notice.  
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Chapter 2 

 

Important Installation Notes 
Please Read Carefully!!! 
 
HRD Software LLC highly recommends you never have more than one copy of HRD installed 
on your computer at any one time.  This can and does in many instances create problems when 
attempting to use either one of the installations. 
 
If you have been running the FREE (V5.x), following these instructions are even more 
important to insure a clean, trouble free installation of the software. 
 
If you are upgrading from the FREE V5.x of the software, it's recommended, prior to installing 
the commercial version 6.x, that you first, follow the instructions in your manual to do a 
backup of your logbook, either to a folder on your computer outside the HRD file structure, or 
to a flash drive, One Drive, DropBox or other cloud storage area.  If you are not familiar with 
this backup procedure, HRD Software LLC has created a YouTube video showing this 
operation.  It was created using V6.0, but the procedure is the same for V5.x users.  To view the 
video, please copy and paste the following link into your favorite Web Browser. 
 
 HRD Logbook Backup - Recovery:   https://www.youtube.com/watch?v=Py4vvj1bRZk 
 
If you have created custom Macros in the DM-780 software, please Save all your custom 
macros, again, to a location outside of the HRD file structure.  If you are not familiar with 
saving your macros, please read your HRD Manual.  There are instructions on saving your 
custom macros so if something happens, they can be easily reloaded into a new version, or 
restored in the event of a system failure. 
 
If you have other custom layouts or configuration options selected, please make screenshots of 
the settings screens and notes of, for example, special layout files, etc, so you can restore these 
settings to the new installation. 
 
Once you have all your items saved or at least notes made for the new installation, you can then 
open your Control Panel > Programs and Features, and proceed to uninstall the HRD software.  
The Windows installer will remove ONLY the HRD Executable, and associated files from your 
computer, so, it's important to remove the rest of HRD before installing the new version. 
 
V5.x stored the user configurable, logbooks and other data in a hidden folder.  First you will 
have to open your Control Panel, select the "File Explorer Options" or "File Folder Options", 
depending on your windows version.  When that window opens, select the "VIEW" tab and on 
the View screen, locate the option to "Show hidden files, folders and drives" and put a tick in 
the radio button. 
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Once that is done, navigate to C:\users\<user name>\AppData\Roaming and locate the 
"Simon Brown - HB9DRV" folder and delete it from your computer. 

Downloading HRD 
Although you may have purchased your Ham Radio Deluxe software through one of our 
distributors, or purchased it on-line with the option to have a CD shipped, it is always a good 
idea to check our website prior to installing the version you received on CD is the same as that 
available on-line. 
 
We do many updates to our software.  Sometimes as often as 2 or 3 new versions a week.  The 
reason for the frequent updates is to fix reported bugs in the software, add new radios to our 
supported radios list, add new features, and other reasons.  There is no fixed time frame on 
publishing a new release. 
 
The CDs are mass produced and provided for our distributors in bulk orders according to what 
they feel they can sell in a certain period of time.  Sometimes, we release a new version, or 
maybe more, before the distributor sells out of their current stock and re-orders.  The CD they 
sell you, although is just fine to get up and running with, may be superseded by an update.  The 
same goes for CDs purchased and shipped from our on-line store, so it's always a good idea to 
check to see if there are any updates to the software. 
 
If you like to always have a CD copy of the HRD software on, just as a backup, you can always 
burn a copy of the downloaded setup file to a CD, or keep it on a flash drive for emergency use. 
 
Downloading the HRD installation file is quite simple.  Just open your favorite web browser 
and go to the Ham Radio Deluxe website by entering  www.hrdsoftwarellc.com or www.ham-
radio-deluxe.com into the address bar.  Once on our website, click the "Downloads" link on the 
top of the page. 
 

 
 
On the Downloads page, you will see two versions of HRD listed.  One is indicated as "Full 
Version" and the other as "Trial Version".  Select the proper option, download and save the 
setup.exe file to your hard drive.  Unless you have indicated otherwise, the default location 
where it will be saved will be in your "Downloads" folder. 
 
Once you have the Setup.exe file on your computer, you're all set to begin the installation as 
described in the next section. 
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Installing The HRD Software 
 
Whether installing HRD from a CD or installing from the downloaded Setup.exe file, the first 
thing you should automatically do is disable any anti-virus software you may be using.  Some 
anti-virus software packages see some files as a threat and will delete them during the 
installation.  The reason for this "false positive", is some of the files in the HRD software are 
used to connect to and transfer data via specific ports on your computer to locations on the 
internet.  Routines that handle, for example, the callsign lookup in the logbook module, or the 
DX Cluster, that depends on an internet connection to receive it's data may be detected as a 
threat just by the way it is coded in the software, or by the simple fact it connects to and 
interfaces outside of the computer to some other location.  You can be assured, though, HRD 
does not contain any type of Malware or malicious code. 
 
Once you have disabled your anti-virus, proceed to install the HRD software using either your 
CD or the Setup.exe file download from our website.  We have made the installation of HRD as 
painless as possible.  Once you start running the "Setup.exe" file or installing from the CD, just 
follow the on-screen prompts to complete the installation. 
 
If you have any issues while installing the software, please, don't hesitate to contact HRD 
Support for assistance. 
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HRD File Locations 
 
The following are the locations of all the HRD system and user files on your computer. 
 
PROGRAM FILES:  These are the executable and all HRD program system files. 
 
Windows 32-bit Systems:  C:\Program Files\HRD Software LLC 
Windows 64-bit Systems:  C:\Program Files (x86)\HRD Software LLC 
 
HRD USER FILES:  These are all the user configurable files and where your Logbook files are 
stored. 
 
All versions of Windows:  C:\Users\\AppData\Roaming\HRDLLC\ 
 
NOTE: The "AppData" folder mentioned in the link above is normally a HIDDEN 
folder and cannot normally be viewed. 
 
In order to view this folder, open your Control Panel.  For Windows 10, select the "File 
Explorer Options".  For all other versions of Windows select the "File Folder Options". 
 
When the File Folder/File Explorer option opens, select the "VIEW" tab on the top of the 
window.  Look for the "Hidden files and folders" option and select the "Show hidden files, 
folders and drives" option as shown below.  Once this is selected, click "Apply" and click "OK" 
and close back out to your desktop.  You can now navigate to the HRD User file location 
indicated above. 
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Uninstalling The HRD Software 
 
At some point in time, you may want to completely uninstall the Ham Radio Deluxe software.  
Whether you have chosen to uninstall or have been directed to do a complete uninstall by our 
support staff the following procedure will assist you in this task.  Unfortunately, at the time this 
documentation was written, HRD does not provide an uninstaller in our software that will 
uninstall everything associated with HRD, so, a full and complete uninstall must be done 
manually. 
 

Getting Started  

Before starting, make sure you have your HRD Activation key available.  You will need it when 
you re-install the software.  If you don't have your activation key, you can e-mail 
sales@hrdsoftwarellc.com and request they send it to you.  
   
Next we need to make a backup of any Logbook databases you may have.  DO NOT use an 
ADIF export for this step.  The ADIF option does NOT include ALL the fields in your logbook 
database, so using this option would result in you losing part of the data for your contacts.  You 
MUST use the BACKUP function in HRD for this step, and, you MUST do it for each database 
you have successfully configured in the software.  These backups should be made to a Flash 
Drive, to your Desktop, to another folder in your Documents folder or to Dropbox or other 
cloud storage location you may be using.   
   
If you are NOT familiar with making these backups, please click on the following link and 
watch the video on our YouTube channel.  HRD Logbook Backup - Recovery:  
https://www.youtube.com/watch?v=Py4vvj1bRZk  
   

Rig Control Settings  

Next, run HRD and in the Rig Control screen, click on the green "CONNECT" icon or click on 
"File > Connect" to open the Rig connection screen.  In the Rig Connection screen, click on the 
"PRESETS" tab and either take a screenshot of this screen or copy down the settings used for 
each of the radios you have connected to HRD.  Make sure you "grab" one of the vertical sides 
of this window and "stretch" is so you can see the complete line for each of the radios you have 
installed.  

https://www.youtube.com/watch?v=Py4vvj1bRZk
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Saving Your DM-780 Macros  

If you have custom Macros configured in DM-780, you will probably want to save these macros 
so they can be restored to the new installation.  At this point, you will want to RUN your HRD 
software and open Digital Master 780.  In DM-780 select "Program Options" and then 
select "Macros." from the menu on the left.  This will open your "Macro Manager"  
 

 
 
In the Macro Manager, click on the "Macro set" dropdown and highlight one of your custom 
macro sets as shown on the left.  Next, on the Macro Manager Toolbar, click on the "Save As" 
button and navigate to a location where you want to save this macro set.  The default name 
will be "DMMacroDefns", which you will need to change to some other unique name to indicate 
what the macros are used for.  Do this same process for EACH of your custom macro sets.  
Each file will be saved as a .XML file in the location you have chosen.  
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Other DM-780 Settings  

Again, in the DM-780 Program Options, select the Soundcard, PTT and Modes + IDs options 
and either take screenshots or write down the settings so you will have them and can restore 
them once you have done the clean install.  
   

View Hidden Folders  

Part of the HRD files are stored in "hidden" folders.  We need to make these files and folders 
visible.  To accomplish this, open your "Control Panel".  

    
If your Control Panel looks like the image above, click the "Category" option and select "Large 
Icons" or "Small Icons", depending on how good your eyesight is..... (I need the EXTRA LARGE 
icons.... HI  HI).  
   
If you're operating system is Windows 10, select the "File Explorer Options".  If your using a 
different version of Windows, you will select "File Folder Options".  
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In this window, select the "VIEW" tab at the 
top.  You will now see the list of folder options 
shown. 
 
Locate the "Hidden files and folders" 
option as shown in the red box in the image to 
the left.  
 
Under that option, put a "tick" in the option to 
"Show hidden files, folders and drives".  
 
Once your selection is made click "Apply" and 
then "OK" to exit this window and exit back to 
the Control Panel.  

 
   

Uninstalling HRD  

Again, open your Control Panel and select "Programs and Features".  In the Programs and 
Features window locate and uninstall ALL versions of the Ham Radio Deluxe software.  
PLEASE make sure ALL versions are completely uninstalled prior to continuing.  

    
   
During remote sessions we have seen where an error will sometimes occur while attempting to 
uninstall a version of HRD.  This is usually due to the fact that another version of the software 
was installed incompletely or an attempt was made to uninstall and was not completed 
properly.  If this happens to you, contact HRD support and you will receive assistance with 
resolving this problem.  If all goes well and ALL loaded versions of HRD are uninstalled, 
continue with the rest of this procedure.  
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Delete All Residual Folders  

Next we need to delete all residual HRD folders from the your hard drive.  First, navigate to the 
C:\Program files or C:\Program Files (x86), depending on whether your using a 32 or 65-bit 
Windows system.  In these locations, locate any folder that relates to Ham Radio Deluxe and 
delete the entire folder.   
   
Locate and open the C:\Program Data\ folder and delete the HRDLLC folder.  
   
Next open the C:\users\<user name>\AppData\Roaming\ folder and delete the HRDLLC 
folder located here.  Also, in this Roaming folder, look for a folder named "Simon Brown" or 
"Simon Brown - HB9DRV" and delete it.  
   

Delete Registry Keys  

Our next step is critical and extreme care should be taken to delete ONLY the keys indicated 
here.   
   

Hold the "Windows" key down and press the "R" key on your computer keyboard.  In the 
"RUN" box, type "regedit" (without the quotes) and press "OK" 

  
 

 

When the registry editor opens, select the 
"HKEY_CURRENT_USER > SOFTWARE" key 
and locate the "Amateur Radio" key.  Left-click on 
the "Amateur Radio" key to highlight it, then, right-
click and select "Delete".  After deleting this key, 
continue down the listing and locate the "ODBC" 
key.  
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Open the ODBC key and expand the ODBC.INI 
key.  Locate any keys that relate to an HRD 
Logbook, whether the default or one you 
created, and delete each key.  Once these 
registry keys have been deleted, close the 
Registry Editor and return to your desktop.  

   
   

Remove Data Source  

Now we need to remove the ODBC Data Source for each HRD logbook databases. At his point, 
you will have to know if your Windows system is a 32 or a 64-Bit system. If you are not sure 
which you have, open your Control Panel and select the "System" option. Carefully read the 
screen to see if you have a 32 or a 64-bit system Windows system installed.  
   
Once you know which Windows system you have, press and hold the Windows key and press 
the "R" on your keyboard or type "RUN" (without the quotes) in the search window, to bring up 
the RUN window.  Below are TWO options.  Select the proper option and type the command in 
the RUN window.  
   
For Windows 32-bit, enter the following command in the RUN window:  
C:\Windows\System32\odbcad32.exe and then press the OK button  
   
For Windows 64-bit, enter the following command in the RUN window:  
C:\Windows\SysWOW64\odbcad32.exe and press the OK button.  
   
When the ODBC Data Source dialog box opens, select each logbook database names.  Left click 
on the database name to highlight it then click the "Remove" button as indicated below.  On 
MOST systems, only the Excel Files and the MS Access Database options will be left after 
deleting all HRD Logbook data sources.  When ALL Logbook ODBC Data Source Names have 
been deleted, click the "OK" button to close the dialog box.  
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Completing The Uninstall  
Back on your desktop, check for any HRD icons that might be remaining.  Right-click on any 
remaining HRD desktop icons and delete them.   
   
You’re now ready to reboot your computer.  Once the computer has been rebooted, you can 
then download and install the current HRD release.  
   
You will need to re-activate the software using your current activation key.  You will also have 
to re-configure the com port settings in the Rig Connect Screen, which shouldn't be too much 
of an inconvenience.   
   
When the Logbook opens for the first time after installation, and prior to attempting to restore 
your logbook database, click on "TOOLS > Configure > Settings"  on the top menu, and make 
sure the option on the bottom that says "Create Default DB if Missing" is unchecked.  If there is 
a check mark in this option, remove it by clicking on it.  
   
Once you have done this, you can restore the Logbook database from the backup copy you 
made in the beginning of this process.  
   
Following this process should give you a full, clean installation of the HRD software.  It should 
resolve many of the so-called "bugs" some are seeing in the program.  
   
If you have any further problems, or questions, don't hesitate to contact HRD support for 
assistance.  
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Chapter 3 

 

Activating HRD 

 
There are two types of activation involved with the Ham Radio Deluxe software.  First is the 
Trial Activation.  This activation allows you to install HRD on ONE computer and use the 
software for a 30 day evaluation period.  The software is not crippled in any way and the trial 
gives you the opportunity to check out all the features of the software. 
   
The second type of activation comes AFTER the trial period, if you choose to keep the 
software.  This activation requires you to purchase an Activation Key, which when installed in 
the Trial version removes the 30-day limitation and activates your perpetual license for the 
software.  
  
Since the software is registered to the owner's callsign, and NOT a specific computer, the 
Activation of the HRD software also creates the "HOME" profile for the registered callsign in 
the "My Station" page in the Logbook.  The "My Station" profile is a GLOBAL profile file that 
provides station information used by all modules in the HRD suite of programs.  Creating your 
"My Station" profile will be discussed in the Logbook manual.  
 
Upon purchasing the HRD software an activation key will be provided.  This key serves two 
purposes.  The first is to remove the 30 day trial limitation from the trial version.  The second 
purpose is to track and validate your Software Maintenance and update agreement. 
 
Your initial purchase and activation includes a LIFETIME license to use the HRD software.  
Once activated, your license for using the software never expires.  You are able to use the HRD 
software for as long as you like.  This license also includes lifetime BUG FIXES, so, it's 
recommended you check our website often and download any new releases to keep your 
software up to date with any new bug fixes. 
 
Your initial activation includes 1 full year of paid technical support from the HRD Support 
Staff.  During that initial year, if you have any problems with the HRD software, you can 
contact the support staff either by phone or by entering a support request ticket on our website.  
The link to enter a support ticket is HTTP:\\tickets.hrdsoftwarellc.com 
 
After your first year, you will notice the License information in the HRD License Manager will 
turn "RED" and will indicate your initial license has expired.  This does NOT mean the software 
will stop working.  What this DOES mean is you can no longer receive paid support from our 
staff.  It also means that, although you can still download and install each and every new 
release to benefit from the bug fixes, however, if any new features have been added after the 
expiration of your license, those new features will be "LOCKED".   
 
If a LOCKED feature is something you would like to use, then you have the option of 
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purchasing a renewal license.  This non-mandatory renewal will again give you one full year of 
paid technical support plus UNLOCK any new features that have been added to the HRD 
software.  The renewal charge is 1/2 (50%) of the current retail price of the HRD software. 
NOTE: There is ONE exception to the above and that is the Country and Unique Callsign 
Databases. The information contained in these databases is constantly updated from various 
outside sources. We have to keep check on each and every one of these sources and manually 
update the Country and UCSDB so that when outdated, you can either automatically update it 
in HRD Logbook, or do a manual update.  For this reason, the Country and UCSDB is included 
in the annual renewal, if you want to update it as changes are made. This is the only feature 
that EXPIRES once a year with the Support Agreement. 

Trial Activation 
Activating the 30-day trial version of HRD allows the operator to evaluate the software to 
ensure it will do everything he/she wants it to do prior to actually purchasing the software.  We 
feel that a 30-day trial is very sufficient time for evaluating the HRD software.  That is why we 
have adopted the Trial Policy we currently enforce. 
 
During the trial period, the operator has full access to the software.  Nothing is crippled.  All 
features function as designed with the possible exception of the HRD Remote Server, due to 
the fact the HRD trial version can only be installed and activated on one computer.  During the 
trial period, you also have access to full support from our support staff, should you run into any 
technical problems that you just can't resolve, so, during the trial, please, don't hesitate to 
contact HRD support should you need assistance. 

Beginning Your Trial 
Upon starting HRD for the first time, you will see the following screens.  Follow the 
instructions on the screen to activate your Trial version.  An activation key is NOT required for 
the trial version. 
 

 

 
<-- Welcome Screen  
 
If you are installing HRD's trial version, you will first see the W           
Click on the [Next] button to continue.  
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<-- Callsign  
If you are a licensed amateur radio operator, your callsign 
must be entered in this location.  Click [Next]  
   
NOTE: If you are an SWL or do not currently have your ham 
radio license, you can use any group of 3 or 4 letters and a 
single number from 0 to 9, such as ABC1, TABE4, GABE2 or 
something similar.  Just make sure the group you choose 
DOES NOT in any way resemble any amateur radio callsign.  

 
 

 

<-- Activation Key  
Since we are activating the Trial version of HRD, you will NOT 
have an Activation Key, so, do not enter anything in this 
screen.  Just click the [Next] button to continue with 
the activation of the Trial version.  

 
After completing the above steps, the HRD License Manager will appear indicating you have 
activated the trial version and will give you the expiration date for the 30-day trial. 
 
At this point, the HRD software has contacted our License Server and has recorded your 
callsign, activation date, expiration date of the trial.  This information is used by the HRD 
Support Team.  In the event you need support during the trial period, it ensures the technician 
can bring up your callsign and verify that you are a trial user and are eligible to receive the full 
support of our staff. 
 
Now that your trial version of HRD has been activated, click on the "CONTINUE" button on 
the bottom of the License Manager to proceed with the configuration of Ham Radio Deluxe 

Full Activation 
Once you have completed the 30-day trial, or at any time during the trial, if you are completely 
satisfied the software will do everything you expect it to do, you have the option to purchase an 
activation key which will remove the 30-day limitation on the version of HRD you have used 
for the trial.  There is no need to install this version and you will NOT lose any of your settings 
or logbook data when you update to the purchased version. 
 
You can purchase your activation key in one of two ways.  You can call our sales department, 
during normal business hours, and they will be more than happy to take your order.  You could 
also make the purchase by using the secure website.  Just go to the HRD LLC website 
(www.hrdsoftwarellc.com), and select the "Purchase" option from the top menu.  You will be 
directed to the page where you can select the option to purchase the FULL version or RENEW 
your previously purchased activation key.  You could also just enter the following link directly 
into your favorite web browser, which will take you directly to the secured link to complete 
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your purchase.  
 
HTTP://www.hrdsoftwarellc.com/cgi-bin/store/commerce.cgi?pid=1 
 
Once you have made your purchase, you will receive an activation key, which consists of 4 
groups of 4 alpha/numeric characters.  All characters in the key are UPPER CASE, and there 
are no "0" (zeros) or "1" (numeral one) in the keys.  Your activation key will be sent to you via 
e-mail, and you can copy and paste the key from the e-mail into the License Manager. 

Entering Your Activation Key  
Once you have your Activation Key, proceed by starting HRD.  On the main menu of any of the 
HRD program modules, click the "HELP" option then select the "HRD License Manager" from 
the dropdown menu.  When the License Manager opens, proceed as instructed below.  
 

 

1. Click on the large "Activate" button 
2. The "Add a new License" window will open 
3. Enter your station callsign 
4. Enter or copy and paste the activation key into 
the spaces indicated 
5. Click "OK" to save your registration data. At this 
point the data entry window will close you your 
new key should be indicated in the License 
Manager. 
 

 
Once you have been returned to the License manager, you will probably have TWO keys shown 
in the License Manager window.  If this is the case, click on the "old" key to highlight it, and 
click the large "Remove Selected License" button.  This will remove the trial key or expired key 
from the License Manager.  This is a necessary step to ensure your system recognizes the new 
key ONLY.  When you have removed any old keys, click the "Continue (6)" button to proceed 
with the HRD software. 

Adding Additional Keys 
Many hams hold more than one active amateur radio license, and would like to be able to log 
calls using that callsign in the HRD Logbook.  Also, many households have more than one ham 
that uses the equipment in the shack. 
 
Each person using the HRD software must have his or her own activation key, likewise, an 
activation key is required for EACH callsign used in Ham Radio Deluxe.  If you have more than 
one callsign or there are other members living in your household who are hams and would like 
to use the HRD software, HRD LLC will proved the additional keys, to the registered owner of 
HRD, at no additional charge.  More information on this can be found elsewhere in this 
manual, or you can contact sales@hrdsoftwarellc.com if you have any further questions. 
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Additional keys are added to the HRD software by basically following the same instructions 
used for entering your activation key when you first registered the software.  On the main HRD 
screen, or in any of the HRD Modules, click on "Help > HRD License Manager" to bring up the 
License Manager screen.  On the License manager screen, click the large "ACTIVATE" button 
and enter the callsign and activation key for the call being added.  Once you click "OK" a 
second license key will appear in the License Manager and a new "profile" tab, for that call, will 
be created in the Logbook "My Station" dialog. 

Expired Activation Keys! 
As mentioned earlier in the documentation, your Activation Key actually provides TWO 
functions.  The FIRST function being to unlock the 30-day limitation in the Trial version, and 
provides a lifetime license to use the Ham Radio Deluxe software for as long as you like. 
 
The SECOND function of the Activation Key allows us to track the Software Support and 
Maintenance Agreement that you agreed to when purchasing the your Activation Key.  This 
agreement has a non-mandatory annual renewal fee of 1/2 (50%) of the existing retail price 
of Ham Radio Deluxe. 
 
As mentioned, this renewal fee is not mandatory, however, purchasing an annual renewal for 
Software Support and Maintenance insures your Ham Radio Deluxe software will be kept up to 
date with all new features added, helps pay development costs, provides salaries for support 
and sales staff, pays for maintaining our website and other day to day expenses of running a 
company.  By renewing this agreement you are supporting HRD Software LLC so we can 
provide continued and better support for YOU, our valued customers. 
 
After the first year, your HRD License Manager will notify you that your activation key has 
expired.  Again, this does NOT mean your current version of HRD is going to stop working.  
What it does mean is, although you can still download ALL future releases of HRD for the 
benefit of "bug fixes", any new features added after the expiration date of your license will be 
locked.  It also means you can no longer get support from the HRD technical support staff.  
Support is still available, however, through our peer-to-peer forums on the HRD website, from 
our YouTube channel and from many Yahoo User Groups who can provide support for those 
with questions or need information about specific radios or hardware used with Ham Radio 
Deluxe. 
 
Once you are notified that your Activation Key has expired, you will see, in the License 
Manager in the software, your Key information is now shown in "RED".  If you choose to renew 
your Software and Support agreement, just go to the HRD website, select the "Purchase" 
option from the top main menu and select the option to "Renew" or "Update" the Activation 
Key.   
 
Just like when you first purchased the HRD software, you will be sent a new Activation Key 
with a new expiration date. You proceed to enter the new key by following the instructions for 
"Adding Additional Keys". Once the key is entered and validated, you will see BOTH keys 
displayed in the License Manager.  At this time, you need to left-click on the "expired" key to 
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highlight it. You then click on the "Remove Selected Key" button to remove this key from your 
system. 
 
You now have access to paid support and the ability to use any new features for another year. 
 
NOTICE: HRD Software LLC reserves the right to change or amend this policy at 
any time without prior notice. 

Troubleshooting A Failed Activation 
In the event your new License Key does not appear in the License Manager,  the following instructions 
may assist you in activating the software. 
 
The most common cause of a failed activation is port 3162 to the internet is being blocked either by 
your firewall or your anti-virus software.  To test to see if port 3162 is being blocked, in the License 
Manager, double click on the "Globe" icon in the upper right corner of the screen.  This will open the 
Port Diagnostics window as shown below. 
 

 
In this diagnostics window, click on the button under "HRD License Server" that says "Test 
Port 3162"  Watch the results in the box to the right of that button and see if it returns a 
"failure" to connect to the HRD License Server.  If you receive a failure notice here, this 
indicates that something on your computer is blocking the port or, in some circumstances, your 
Internet Service Provider may have the port blocked for some reason. 
 
At this point, you can try disabling any Anti-Virus and Firewall programs you may have 
running and re-try the activation process.  You should also check to ensure you do not have a 
firewall in your router that could be blocking the port. 
 
If disabling the firewalls and anti-virus fail to allow you to activate HRD, you might also try 
starting your computer in "Safe Mode with Networking" and attempt to active HRD from 
within Safe Mode.   If this fails, contact your Internet Service Provider's support and see if 
possibly they have port 3162 blocked for some reason.  Once you have the software activated, 
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restart the computer in normal Windows mode and proceed with your setup. 
 
If all of the above fail to allow you to activate HRD, please contact HRD Support for further 
assistance. 
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Chapter 4 

 

Testing The HRD Software 

  
We now have Ham Radio Deluxe installed and our radio ready to be connected, lets test the 
HRD software to make sure it is installed and operating properly.  This is done using one of the 
built-in Dem-o-matic radios. 
  
The Dem-o-matic radio is ideal for testing the software installation or demonstrating Ham 
Radio Deluxe without having to have an actual radio connected.  Running HRD with one of the 
Dem-o-matic radios before actually connecting your radio equipment, you get the opportunity 
to make sure your installation went well and the HRD software is loading and operating as it 
should.  
Run the Ham Radio Deluxe software by double-left clicking on the HRD Desktop icon. Once 
the splash screen has closed you see the Connect window. If you do not have the correct 
connection cable for your particular radio, select one of the Dem-o-matic radios so that you 
can open Ham Radio Deluxe.  
 

 

<--Dem-o-matic  
 
The Dem-o-matic radios do not need cables – 
simply select Dem-o-matic in the Company drop 
down, select an option in the Radio drop down, 
and then press Connect.  This will then open the 
main Rig Control screen giving you access to the 
simulated HF radio chosen from the Radio 
dropdown menu in the configuration window.  

 
Once you have selected the Dem-o-Matic radio as shown above, click on the "Connect" button 
to actually connect to the radio and bring up the Rig Control screen.  
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From the Rig Control screen, you can now start and test the other four modules of HRD by 
clicking on the individual icons shown in the "red box" on the Icon Toolbar.  
   
The Dem-o-matic radio feature in HRD can also be valuable as a diagnostic tool.  If you are 
having issues with HRD, you can run one of the Dem-o-matic radios to check if the issue you 
are having is related directly to the software or if it is between the interface and your own 
radio.  If you run in the Dem-o-matic mode and the issue you are seeing disappears, you know 
the software is functioning as it should and the problem you are seeing is either related to the 
interface your using, such as the Com port drivers, cables or other hardware connected 
between the computer and the radio, or, possibly an issue with the radio itself.  
 

Rig Connect Screen 

 
Once HRD has been activated the next screen you will see is the Rig Connection screen.  Here 
is where you configure Ham Radio Deluxe to connect to the particular radio you are using. 
 
The Rig Connect screen has 4 tabs across the top.  Each tab contains specific information which 
helps HRD connect to your radio. 
 
You will also notice other check boxes for additional options on the lower portion of the Rig 
Connect screen.  When setting up HRD for the FIRST time, it is recommended you DO NOT 
check any of these boxes.  The first and most important operation at this point is to connect to 
the radio and start the main HRD software.  We will explain how to set these other options 
once we get the radio connected and the HRD Rig Control module running. 
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New Tab 
 

 

<--The New Tab 
 
The "New" tab is used to configure HRD to 
connect to a new radio being added to the 
system.  Here is where you select the radio 
Manufacturer and radio model.  We also 
configure the Com port and port speed used 
by the Rig Control software in HRD to 
connect to the CAT firmware in the radio.   
  
Other items that are configured on this tab 
are the CI-V address used by Icom radios 
and the Flow Control settings (CTS, DTR 
and RTS lines). 
  
Note: Most Yaesu and Icom radios require 
only the RTS item to be checked while 
Kenwood requires the RTS and CTS to be 
checked. 

 
 
 

Preset Tab 
 

 

<--The Preset Tab 

 
Upon first starting the HRD software, the "Preset" tab is 
empty.  Once you have successfully configured and 
connected to your radio from the "New" tab, an entry will 
automatically be added to this tab with the information 
about your connection.  This serves TWO purposes.  First, 
it gives you a record of the configuration used to connect 
to your radio and the second is, if you have more than 
ONE radio connected to your computer and HRD, this is 
where you can select which radio or radios you want to 
connect during an operating session. 
  

 
Once you have your radio or radios configured and connected to HRD we HIGHLY 
RECOMMEND you take a screenshot of this screen and keep it in a safe place.  This will come 
in handy if for some reason you need to re-configure a radio connection for any reason you 
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have the actual settings used, so there's no guessing or searching for the settings needed. 
When you have a radio or radios configured in the "Preset" tab, to start that particular Rig 
Control, just left-click on the selected radio and click the "Connect" button. 
  
If you have a radio configured on the "PreSet Tab", which you no longer own or have connected 
to Ham Radio Deluxe, you can easily remove it from the Presets by clicking on the setup line in 
the display window, to highlight the unwanted configuration, and click on the "X Remove" 
located on the left just below the slider near the left center of the dialog box. 
 
 

Serial Ports Tab 
 

 

<--Serial Ports Tab  
 
This tab displays the Com ports available on your 
computer.  It can come in handy as a quick reference 
when trying to find what port your radio is connected 
to.  
   
Just below the main window, there are two options 
which can be selected.  One is to "Show ALL ports" and 
the other is "Only ports connected to PC".   

 
If you have the "Show ALL ports" ticked, if you have ever had any device connected to this 
computer that required the use of a Com port, and a device driver was installed, it will show up 
in this list.  If you have ports showing in this list that are no longer used or needed, it's 
recommended you uninstall the ports and drivers for the particular ports.  
   
If you tick the "Only ports connected to PC" only the currently active ports are shown.  These 
are ports that have devices connected to them, such as your printers, radios, or any other 
device that requires connection via a Com or printer port.  

Help Tab 
There is a 4th tab on the connection screen that, at the time this document was written, is not 
currently populated or used. 
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More Features 
Along the bottom of the Rig Connect screen are a series of check boxes.  These are used to allow 
HRD to start with the options you have selected. 
 

 
 

1. Connect Button - We all know what this does.  Clicking this button starts the HRD software. 
 
The check boxes: 
● Always connect to this radio when starting HRD Rig Control - If you have more than one 

radio configured to use with HRD, this allows you to select one specific radio you may want 
to start each time you start the HRD software.  Just highlight the radio in the Preset tab, and 
check this box to start that radio when you start HRD. 

● Start HRD Rig Control in Full Screen mode - Checking this box allows the HRD Rig Control 
to start in full screen, which means there are no menus and no toolbars displayed.  This 
option isn't recommended for new users until you become familiar with the operation of 
HRD.  If you check this by mistake and the screen does open in full screen mode, pressing 
your "F4" key, on the keyboard will return the display to the normal mode with menus and 
toolbars. 

● Auto Exit - At the time this document was written, this option was disabled. 
● Auto Start - Since some people use specific modules in HRD during their sessions, here you 

can select which modules you want HRD to automatically start when starting the main 
program from the desktop icon.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



HRD Rig Control V6.3          Copyright © 2016 HRD Software LLC         

 

51 

 

Connecting Your Radio 

 
Before we start this next section, PLEASE DO SOME HOMEWORK!!!  
 
VERY IMPORTANT!! - If your radio has the capability to connect to the computer 
via a USB connection, it will require a driver to create the virtual COM Port used 
to connect.  BEFORE you connect the USB cable from the radio to the computer, 
you MUST FIRST download and install the driver.  This is because if you connect 
the cable first, Windows will search the internet and install a "Generic" driver.  
These drivers may work, but you may also see problems.  The reason, radio 
manufacturers have, in many cases, modified the drivers to suit their needs.  
Although the generic driver may work, it does not contain the tweaks the radio 
manufacturer applied for the driver to function the way THEY want it to.  So, if 
the manufacturer of your radio provides a driver on their website, it's very 
important you download and install the specific driver suggested or posted on 
your radio's manufacturer's website and NOT allow Windows to install the 
generic driver. 
  
Your radio owner's manual and the Ham Radio Deluxe manual are your BEST FRIENDS when 
it comes to configuring the Rig Connection.   If you don't have these manuals, you can usually 
download your radio's operating manual from the manufacturer's website in PDF format.  You 
can also download the HRD V6.x manual from the download page at www.hrdsoftwarellc.com. 
  
Many of today's radios have extensive menu systems built in.  During the connection process 
and at other times while configuring the HRD software, you may have to refer to locations in 
these menus to set options or make changes that effect the connectivity and operation of your 
radio with the HRD software.  It is VERY IMPORTANT that you KNOW and UNDERSTAND 
how to operate the menu systems in your radio.  There may be a time when you have to contact 
HRD Technical Support for assistance with some issue you are having and the technician may 
ask you to check certain menu options in the radio.  Knowing how to do this is YOUR 
responsibility and not that of the HRD technician. 
  
Read your radio's manual to find out exactly how it is supposed to be connected to a computer 
for CAT control. Some radios require special drivers to be loaded in the computer to access 
certain model radios. These drivers can usually be downloaded from the manufacturers 
website. All this information is in your radios user manual or from the radio's manufacturer 
tech support. 

Please refer to "Radio Interfacing" in the Introduction section. to review the requirements for 
Ham Radio Deluxe interfacing. 
  
To connect your radio you will need to connect the necessary cables and install drives if 
needed. You must also do some configuring within Ham Radio Deluxe. This is usually a one 
time exercise. 
Once you have all your cables in place it's time to turn on your radio, boot up your computer 
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and start Ham Radio Deluxe. The next screen you should see is the radio connection setup 
screen. This is where you select your radio and set some parameters to allow the Ham Radio 
Deluxe Rig Control software to connect to your radio. 

Connecting Flex and SDR Radios  
SDR radios present an entirely different situation.   These radios require special SDR software 
such as PowerSDR, SmartSDR, or other SDR software as PART of the radio's operating system.   
They also require some virtual Com port and virtual Audio Cable software in order to connect 
with Ham Radio Deluxe and your SDR software.   The Flex SmartSDR software package 
contains everything you need as far as the virtual Com port drivers and virtual Audio cable 
software.  If your SDR radio requires some other software, your radio manufacturer or the 
dealer where you purchased your SDR radio should be able to help you with these items and 
assist you in getting your SDR up and running. 
  
Once you have your SDR radio up and running, with all the required virtual Com port drivers 
and Audio Cable software loaded and connected,  if you have any issues connecting with the 
HRD software, then, and ONLY then, the HRD Tech Support staff can assist you.   

Let’s Get Connected 
The following section will guide you through connecting your own radio equipment to HRD.  
These instructions are rather generic, but they apply to ALL radios supported by the HRD 
software.  In our examples we will be connecting to a Yaesu FT-950. 
  
Note To Icom Users:  All Icom radios and a few others that use the CI-V protocol for 
sending commands to and from the radios, have a special setting known as the CI-V Address.  
Each message (frame) sent to a rig or received from a rig contains two addresses. The 
destination (to-address) and the sender (from-address). Each model has it's own default CI-V 
address, which can be changed by the user. If two or more rigs of the same model are used on 
the bus (or level converter), you need to change the addresses of the rigs, each individual rig 
must have it's own, distinct address. Valid addresses as defined in the Icom CI-V Reference 
Manual (3rd edition) range from $01 to $7F. 

There are some reserved addresses with special meaning: 

● $00: Used as to-address, means all connected rigs. 
Any rig with CI-V Transceive set to on should react to commands adressed to $00. 
Any rig with CI-V Transceive set to on addresses it's messages to $00 when tuning the 
dial, changing mode etc. 

● $E0: Reserved for the controller, i.e. the computer. But to my knowledge no rig really 
cares where the messages come from, so any address could be used as from-address. 

● $FA ... $FF: Reserved for protocol functions such as frame delimiters, Ok, Not-Good, 
collision signals, empty memory etc. These values must not be used as addresses. 

Another setting in the Icom radios is the CI-V Transceive.  Unless you are using other Icom 
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hardware that requires it, such as the PW-1, HRD recommends turning the CI-V Transceive 
to OFF in the radio's menu system.   

 

Kenwood: make sure Packet communication mode is switched OFF (if 
supported). Most Kenwood radios require CTS and RTS to be ON for flow control. 
  
These options are set from within the radio's menus.  You can find the menu number and 
directions on how to change these setting in your radio's owners manual. 
 

 

<--Company 
  
In the Rig Connection screen at the left, select the 
"Company" dropdown menu and indicate the 
manufacturer of your radio in this field.  In this 
instance, we are showing "Yaesu" as the 
manufacturer.  Once you have selected the 
manufacturer, move to the "Radio" dropdown. 

 

 

<--Radio 
  
Here we select the Model of the radio we're 
connecting.  This selection also selects the CAT 
command set used in HRD to control the radio you 
select. 
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<--COM Port 
  
Select the Com port the CAT control interface uses 
to communicate with the radio's command set.  
You can select this based on observations in the 
Device Manager.  If you are unable to determine 
what Com port is used, you can use the "Auto-
Detect" function at the bottom of the Com port list.  
If using the Auto-Detect option, once you begin the 
connection process you will see, in the "Status" 
window how HRD tests each port connected to the 
computer to see if it finds your radio. 

 
 
 

 

<--Speed 
  
The Com port "Speed" is selected based on a setting 
in the radio's menu system.  Usually checking the 
radio's manual will provide a list of baud rates 
available for use on the Com port.  The speed set in 
the HRD Connect dialog MUST MATCH the speed 
set for the Com port baud rate in the radio's 
internal menu. 
  
 

 
Most radios provide a DEFAULT setting, for Yaesu it is normally 4800.  You should always try 
the connection using the default speed first. If you have difficulties maintaining a connection 
then try different speeds. 
  
If you DON'T know the default speed, here again, there is an "Auto-Detect" option which can 
be used.  HRD will check each port at each speed the radio is capable of handling until it finds 
the correct one for connection. 
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<--Other Settings  
 
CI-V Address  
ICOM only: the address assigned to the radio, 
consult the radio's documentation for the default 
address. This can also be configured via the radio's 
configuration menu.  
 
CTS  
Enables the CTS flow control, required for 
Kenwood radios.  
 
DTR  
Enables the DTR line when the COM Port is opened 
and leaves it on, usually to provide power for an 
interface cable. For Yaesu CT-62 and ICOM CT-17 
interfaces this can be left unchecked (off).  
 
RTS  
Enables the RTS line when the COM Port is opened 
and leaves it on, usually to provide power for an 
interface cable. For Yaesu CT-62 and ICOM CT-17 
inter- faces this can be left unchecked (off).  
Next, put a check in the boxes for DTR and RTS. 
Some radios don't require both of these settings 
checked so they can be unchecked if there is a 
failure to connect to the radio.  
 

Caution:  If you have entered a connection "speed" or selected "Auto-Detect" in the speed field 
and then check or uncheck one of the CTS, DTR or RTS boxes, the "speed" will revert to the 
fastest speed available, so, you want to double check this prior to hitting the "connect" button 
to make sure the entry in the "speed" field is correct. 
 
Once you have all the settings in the Rig Connection screen selected, click on the "Connect" (3) 
button.   
 
If, during the setup of the Rig Connect screen, you were not sure of the COM Port or Speed 
settings, the "Auto-Detect" option in those Dropdowns could have been selected.  If this was 
done, when you click the "connect" button, you will see activity going on in the "Status" 
window.  HRD is checking each COM Port at each speed.  Once it finds a COM Port and speed 
that matches that of your radio, it will immediately connect and the Rig Control Screen will 
open. 
 
If you know the correct COM port and port Speed, and have entered them correctly in the 
fields, the HRD Rig Control screen will appear almost immediately when you click the 
"connect" button. 
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Chapter 5 

The Rig Control Screen 

 
Once you have successfully connected to your radio, the first screen that will appear is the Rig 
Control Screen.  This is a generic screen and is basically the same for all radios regardless of the 
manufacturer or model.  The only difference between radios are the functions displayed on the 
screen.  The buttons and functions on the screen are dependent on the CAT firmware in each 
model radio.  Different radios will display different functions in the Rig Control screen.  The 
screen used in this section is that seen when connected to an Yaesu FT-950.  This display is 
typical of what most radios display, although some show more control buttons and sliders and 
some show less, but the main layout is the same.  
 

 
 

There are actually TWO views available for the Rig Control screen.  The first view being as it 
appears above showing the Main Menu options and the Toolbar Icons.  The alternate view is 
shown in the next image and is considered the "FULL SCREEN" view.   
   
By pressing the "F4" key, on your keyboard, you can toggle between the Normal 
and the Full Screen view.  
   
In the Full Screen view below, the Main Menu and the Icon Toolbar are not visible.  You will 
notice the icon indicated by the red box and arrow on the screen indicates you are in Full 
Screen mode and reminds you to press the "F4" key to return to the alternate view.  This icon, 
if it appears on top of any major controls or buttons, can be moved out of the way by left-
clicking on the icon, holding the mouse button down while sliding the icon to a location on the 
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screen where it no longer is covering any controls or buttons.  
 

 
 

If you have inadvertently checked the "Start HRD in the Full screen mode" in the Rig Connect screen, 
you can change that from here very simply press the "F4" key on your keyboard to switch to the 
normal mode.  Once in the normal mode, click the Connect icon on the left of he main toolbar (green 
icon with white arrow in it) to open the Rig Connect screen, and uncheck the "Start HRD in Full 
Screen Mode" check box and close that screen.  Next time HRD starts it will start in the normal view. 
 

Rig Control Main Menu 
 
The Rig Control Main Menu is the "TEXT" menu located at the very top of the NORMAL RC 
Display.  Below are a list of the options for each of the menu headings.  We will discuss these 
options as we go through the manual. 

File Edit View Bands Favorites 
Connect  Ctrl+B 
Disconnect 
Print Setup 
Reset 
Restart 
Exit 
 

Undo     
Ctrl+Z 
Redo     
Ctrr+Y 
Copy Freq     
Ctrl+F 
Copy Mode  
Ctrl+M 

Main 
Edit 
Program 
Various 
Main Tabs 
Toolbar 
Text 
Status Bar 
Full Screen  
F4 
Advanced 
Customize  
> 
Color 
Schemes 
Layout Size  

Manager  
Ctrl+B 
Band Up  Page 
Up 
Band Down  
Page Dn 
Out Of Band 
Warning 
Display 
Bandspread: 
25kHz 
Bandspread: 
50kHz 
Bandspread: 
100kHz 
Bandspread: 

Add  Ctrl+A 
Manage  
Ctrl+O 
Show 
Markers 
Marker Size 
Display 
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> 
Advanced 
Options  F3 
Next Slider 
Layout F5 
Selection Window F10 
Slider 
Controls F6 

250kHz 

Quick Save Macros Logbook Radio 
Options 

Scanning 

Add  Ctrl+Q 
Erase 
Erase All 
Next  Ctrl+F5 
Previous  
Ctrl+F6 
Show Markers 
Marker Size > 
Display 
 

Macro 
Manager 
Snapshot  F9 
Display 
CAT 
Command 
Manager 
Display 

Display Options -->     > 
<--     > 
<->    > 
Scan Range 
Scan This 
Band 
Scan 
Frequencies 

Tuning Tools Voice DStar Windows 
Enter Freq  <ENTER> 
Tuning Hints 
Fixed Steps 
Auto-Center 
Mouse Wheel 
Show Fine II 
Synchronisation 
 
Fine I-1.0 KHz 
Fine I-2.5 KHz 
Fine I-5 KHz 
Fine I-10 KHz 
Fine I-25 KHz 
Fine I-50 KHz 
Fine I-100 KHz 
Fine I-200 KHz 
 
Fine I-1.0 KHz 
Fine I-2.5 KHz 
Fine I-5 KHz 
Fine I-10 KHz 
Fine I-25 KHz 
Fine I-50 KHz 
Fine I-100 KHz 
Fine I-200 KHz 
 

Archive 
Add Desktop 
Icon 
Audio 
Browser 
Audio 
Grabber 
Bandscope 
(ICOM) 
Bandscope 
Browsers > 
Calendar 
Command 
Tester 
DDE 
Monitor 
LDG Elect. 
ATUs 
Lock 
Program 
Shortwave 
Database 
Transverter 
Tune-Up 
Programs  > 
Hardware  > 
IP Server 
Web Page 
Updates 
Extended 
Menus  > 
Memory 
Management  
> 
HRD 
License 
Manager 
Customize 
Layout  

Frequency    
Shift+F9 
Freq + 
Mode  
Shift+F10 
Mode  
Shift+F11 
SMeter  
Shift+F12 
Speak 
Tooltips 
Enable  
Ctrl+Alt+V 
 

DStar Chat Cascade 
Tile 
Arrange 
Icons 
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Ctrl+F8 
HRD Global 
Settings 
Program 
Options  F8 

There is ONE option not shown above.  That is the "HELP" menu which contains the help options 
available from the Rig Control screen. 

Rig Control Toolbar 
Other HRD applications can easily be started from the Rig Control Screen.  The selected 
applications can be manually started from the Normal view of the RC Screen toolbar by 
clicking on the respective icon.  Although each of the HRD modules can be automatically by 
selecting them from the check box list in the Rig Connect screen, the manual method is usually 
recommended since the choice of what we start can change from session to session.  The HRD 
applications these icons open are pretty much self-explanatory. 

  
Other icons on the Rig Control Toolbar include: 

  

 The "Connect" icon opens the "Rig Connect" screen.  This was the first screen that 
appears when HRD is set up allowing you to configure your radio, port, port speed   
and other options used on HRD startup. 

  

 The "Selection" option opens several other HRD feature options for configuring the 
way HRD operates.  These options will be covered in a separate section of the 
manual. 

  

 The "Favorites" are like the Memory channels in your radio.  Here you can store 
and recall, with just the click of the mouse, your favorite frequencies and label them 
under bands or names, such as a net name or repeater name. 

  

 If your listening to an interesting net on a certain frequency and want to 
temporarily store the frequency for later recall, you can save it with the Quick Save 
function. 

 

 

 Toggles full screen mode of the Rig Control Screen 

  

 If you have the SWL Database installed in HRD, this option opens the SWL 
function in Rig Control to allow you to select frequencies from the database and 
automatically tune your radio to that frequency and mode. 

  

 If your radio has sliders that can be configured, this option toggles the display of 
the sliders on the bottom of the HRD Rig Control Screen. 

 

 This option opens the "Customizing" options menu.  This utility allows for 
customizing the HRD Rig Control display screen to your personal liking. 
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 The "Options" dialog allows configuration of specific options and functions in Rig 
Control. 

 

 Clicking on this icon opens your default web browser to the HRD Support Forums 
at www.forums.hrdsoftwarellc.com.  Here is where you can receive peer-to-peer 
support for your HRD software if you opt to not renew your Support and Software 
Maintenance Agreement after your first year. 

 

Configuring Time & Date 
The time and date can be displayed in two locations on the HRD Rig Control screen.  The 
image below shows the locations.  To configure how the date and time is displayed is done by 
clicking on the text shown in the red boxes and using the check boxes in the pop-up screen. 
 

 
 
 

 

Clicking on one of the date/time displays indicated in the red 
boxes in the image above opens the pop-up on the left.  If you 
look at the top of the popup, you will see "Clock Format: 
Right", which indicates I have clicked on the time display on the 
right on the RC screen.  Notice you have the option to display 
clocks on the Left, Right or Both sides of the display, as we have 
done above. 
 
In this configuration I have chosen to show "Local" time only, 
and have selected to show the time in the HH:MM:SS format. I 
have chosen NOT to show any date on this side.  When I clicked 
on the date/time display on the left, I chose to display just the 
date in the "Long" format which is the "Day of the week Month, 
dd, yyyy. 
 

 

Setting Proper ITU Zone 
The first setting you need to make in the Rig Control screen is to select the proper ITU Region 
you are located in.  Not having the proper region selected could have serious consequences if 
you have a region selected that allows you to operate on a frequency in a band that is 
prohibited in your particular region. 
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The International Amateur Radio Union (IARU) is an organization consisting of over 160 
national amateur radio societies around the world.  
   
Created in Paris, France, the International Amateur Radio Union has been the watchdog and 
spokesman for the world Amateur Radio community since 1925. , last amended in 1989, 
organizes the Union into three Regional Organizations that correspond to the three 
radio regions of the(ITU).  
 

 
 

The 3 world ITU regions are shown on the map above.  
 

 

In each of these regions, the ITU has designated certain 
frequency ranges and restrictions for each amateur 
radio band.  HRD has pre-configured the frequencies 
for the HF bands from 10 to 160 meters for each of the 3 
ITU Regions.  If the wrong region is selected you could 
possibly be operating on an out of band frequency for 
your region, or, you may not be able to tune the full 
range of frequencies available for your region on a 
particular band.  
   
In the HRD Rig Control screen, on the toolbar, click on 
"Selections" then select the "BANDS" menu.     
Make sure you have the proper region selected for 
where you live.  
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Another way of selecting the proper region bandplan is by left-clicking on the bandplan 
indicator on the Rig Control screen and selecting the proper operating region from there.  
   

 
 

Connecting Multiple Radios 
HRD has the capabilities of connecting to multiple radios at the same time.  The number of 
radios you can connect to are limited by the power of your computer and the number of 
available ports. 
 
Normally, a laptop has very limited current available on the USB ports, so connecting more 
than one or maybe two radios to a laptop is about the limit.  One way around this, though, is by 
using a powered USB hub.  These hubs have their own external power supply and do not 
depend on power from the computer's USB buss to operate.  You can usually connect three or 
maybe 4 radios to one of these hubs and operate them successfully using the HRD software. 
 
Connecting multiple radios to HRD is quite simple.  Connect your first radio in the normal 
manor and get it up and running in the Rig Control window as described in the Getting Started 
chapter of this manual.  Once you have your first radio connected and being controlled by 
HRD, your ready to connect the second radio. 
 
Make sure your second radio is interfaced to the computer, just as you did for the first, using 
the proper cabling and interfacing method just as you did for your first radio.  Once it is 
connected to the computer, verify the Com Port it is connected to in the Device Manager or you 
can use the "Auto-Detect" options as explained in the Getting Started chapter. 
 
Now, have the HRD Rig Control screen up and running with the first radio connected and 
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operating.  On the Main Menu, click on "File (#1) and Connect" from the dropdown menu or 
click the "Connect" icon (#2) on the Toolbar.  This opens the Rig Connection screen just like we 
saw in the Getting Started section. 
 

 
 
In the image above, we are using the Demomatic radios just for illustration, but the principal of 
the setup is the same. 
 
Make sure you select the Radio Manufacturer, the Radio Model, select the Com Port, if known 
or select "Auto-Detect", select the port speed, if known or "Auto-Detect", make sure the proper 
CI-V address is selected, in the case of Icom radios and make sure the proper Flow Control 
options are checked (CTS, DTR or RTS) as required for your specific radio. 
 
In the lower part of the Rig Connect screen, make sure you DO NOT have any of the other 
options selected.  You may have the "Auto-Exit" options selected, but DO NOT HAVE 
CHECK MARKS IN ANY OTHER OPTIONS IN THE LOWER SECTION OF THE RIG 
CONNECT WINDOW WHEN PLANNING TO CONNECT MULTIPLE RADIOS! 
 
Now, click the "Connect" button to connect the second radio to the HRD operating system. 
 
When the second radio connects, you will see both radios as "TABS" on the RC screen as shown 
below. 
 

 

Clicking on the respective radio tab will bring that radio into 
focus in Rig Control and allow you to control all of it's functions.  
Only ONE radio can be active at any one time from the Rig 
Control Screen, however, you can switch back and forth between 
any number of radios you have connected to the HRD system. 
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Selecting the "WINDOWS" option from the Main Menu will allow you to display multiple 
radios in different ways on your screen.  Selecting the "Tiles" will allow you to display the two 
radios, each in a split window on your display.  Clicking on the header bar for the particular 
radio will make that radio the one that is ACTIVE in the system.  Experimenting with other 
ways of displaying multiple radios on the screen can produce some interesting results.  Don't 
be afraid to experiment with arranging the tiles in different ways. 

Rig Control Tour 
The Ham Radio Deluxe program has many, many features. This section attempts to describe 
the essentials you need to know to get started. Ham Radio Deluxe is designed to be intuitive;  
Nevertheless even the most experienced user has problems remembering all the available 
options! 
 

Tuning the Radio 
OK! We know you want to find if this software works. Take a few minutes to search the bands 
to see if you can hear anyone. Please come back and we will help you get more comfortable 
with the many features and benefits of Ham Radio Deluxe. 
 

Frequency Selection 
You can adjust or select a frequency in several different ways. The currently active digit has a 
bar above and below the digit. Our example above has the active     digit, which is 3, for the 
main band and for the MHz "5" on the sub band. You can change the active digit by either 
clicking on it or using the left or right arrow keys. 
  

Mouse Wheel 
When you rotate the mouse wheel in the frequency display the currently active digit is 
incremented / decremented depending on the scroll direction.   If you rotate while the cursor is 
over an inactive digit then the digit is activated. 
Up/Down Arrows 
The up-arrow, down-arrow, - and + keys increment / decrement the active digit. 
 

Mouse-click 
Select a digital by clicking over the digit. To increment / decrement click above/below the 
center of the digit and keep the mouse button pressed. 
 

Direct Entry 
You have two ways to do direct entry of a frequency. 
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Choice A 
To enter values just press a numeric key (0-9). The active digital is updated and the next digit 
to the right is made active. 

Choice B 
With your cursor placed anywhere with the rig control window press Enter to display the 
Enter Frequency window.  Enter the new frequency, and then press Apply. If you check Auto-
apply then the new frequency is applied every time you make a change. If you check Track this 
window is updated with changes made to the frequency display – for example when you tune 
the radio manually. 

Fine Tuning 
There are two fine tuning ranges – Fine I and Fine II. In the Tuning menu select Show Fine II 
to show the second range. (If you are only showing the default Fine I, then the title is Fine.)  Set 
the range from the Tuning menu or by clicking the button. To change the mouse wheel step, 
click the button (also set with the Mouse Wheel pane of Program Options).  This allows you to 
easily make small adjustments in the frequency. To change the frequency either: Drag the 
marker with the mouse (and keep on dragging – the bar will scroll to the left or right), Rotate 
the mouse wheel (press Shift to increase the mouse wheel step by a factor of 2, press Ctrl to 
increase by a factor of 5), Click in the tuning bar or on frequency text such as 14.235.0. 

Main Tuning 
The differences between a main tuning bar and a fine tuning bar is that the main tuning bar 
shows the whole band range as defined by the band layout. 

Band Selection 
The Band Section buttons are shown between the Fine and Main layouts.  The buttons 
currently displayed are: ALT, BSP, Band buttons – 160m, 80,... and 10m.  

 
  
ALT – only displayed if you have two VFO's displayed (for example Kenwood TS-2000), 
switches between the main and alternate (second) VFO. When high- lighted you are tuning the 
second VFO with the tuning dial. 
BSP (bandspread) – when you press BSP a new layout is dynamically created. The current 
band is split into multiple segments, for example the 20m band (14 MHz – 14.350 MHz) can be 
split into 7 segments,  
each of 50 kHz. To restore the previous layout press BSP and select Off.  The band buttons 
select the corresponding band; the last used frequency and mode for the band are restored. 
They also show which bands are currently displayed.  The displayed bands have the text in 
white while the hidden bands text is displayed in grey. 
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Display Scroll 
If there is not enough room to display all the frequency ranges defined in the current band 
layout use this button to scroll the frequency ranges (bands) up or down. 

Mode Selection 

 

As you would now expect, there are several 
ways to select your operating mode. The most 
obvious method to click on the small mode 
display above your dis- played frequency.  A 
small button just above the frequency display 
shows the current mode. To select or change 
the mode click on this button. A drop-down 
menu will come up where you can choose 
which operating mode you want to use.  

 
 

 

Another method of selecting an operating mode is to press 
the Selection button in the toolbar.  Locate and open the 
Mode menu and select your operating mode from this 
menu. 

 
 

 

In many rig configurations, there may be a 
button pre-configured which contains a list of 
modes.  This button is usually located in the 
upper right corner of the button display at the 
top of the screen. Press the selection arrow and 
make your choice. 
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Radio Sliders 

 

On the toolbar, you will see the "Sliders" icon.  Clicking on this icon, 
and depending on the radio connected to HRD, you will have a group 
of sliders appearing on the bottom portion of the Rig Control screen.  
These sliders control a number of normally adjustable functions 
associated with the radio connected. 

 

 
 

Moving HRD To A New Computer 
Many users have requested instructions on moving HRD from one computer to another.  In the 
past, we have recommended using the "ARCHIVE" feature in HRD Rig Control to move HRD 
from one computer to another.  In most cases, moving from one computer to another is still 
going to require some re-configuration of the HRD software.  Drivers for the radio interface 
will have to be re-installed on the new computer, ports will more than likely be different, other 
settings my change as well. 
 
This section of the documentation will explain, what we consider, is the easiest and most 
reliable way to move your HRD installation from one computer to another. 
 
The first step is to prepare the new computer.  If these steps are followed, moving from one 
computer to the other should be painless. 

Preparing The New Computer 
1. Download and read the HRD Quick Start guide from the following link:        
http://www.hrdsoftwarellc.com/HRD%20Quick%20Start%20Guide.pdf 
2. Disable all firewalls and Anti-virus on the new computer 
3. Download the most recent version of the HRD software to the new computer.  Click on the 
following link to immediately begin the download:   http://www.hrdsoftwarellc.com/setup.exe 
4. Download any drivers required for your radio or interface. 
 
Once you have done the above, install the radio or interface drivers, connect the radio to the 
computer and install the HRD software.   
 
Follow the instructions either in the HRD manual or in the HRD Quick Start guide to activate 
the HRD software on your new computer by using your current Activation key.  Once you have 
the HRD software activated, proceed to setup HRD in the normal manner.  You should have 
this new copy of HRD up and running with an empty logbook, and other default settings prior 
to transferring anything else from the old computer. 

http://www.hrdsoftwarellc.com/HRD%20Quick%20Start%20Guide.pdf
http://www.hrdsoftwarellc.com/setup.exe
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Now, move to the old computer and put an empty flash drive into one of the USB slots. 
 
Start HRD running on the old computer and bring up your logbook and DM-780. 
 
In the Logbook, right-click anywhere on the logbook grid to bring up the "context menu". 
 

 

In the context menu, select "Backups > Options" as shown 
in the image to the left. 
 
 

 
 

 

Uncheck ALL of the options except the "Save File in 
Folder" option. 
 
Click on the navigation box (Red arrow) and navigate to 
the flash drive you inserted into the computer earlier.  
Click on the Flash Drive drive letter and click on "OK" to 
select. 
 
 
 

 
Once you have the Flash Drive option selected, close this window and again, right-click on the 
logbook grid to open the context menu.  Select "files > backups>" and click on "Backup" to do a 
full backup of your logbook.   
 
When the backup is completed, check your flash drive to make sure an XML backup was 
created.  If it was, your now ready to open DM-780 and prepare any custom macros you want 
moved to the new computer. 
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Saving Custom Macros 
If you have custom Macros configured in DM-780, you will probably want to save these macros 
so they can be restored to the new installation.  At this point, you will want to RUN your HRD 
software and open Digital Master 780.  In DM-780 select "Program Options" and then select 
"Macros.." from the menu on the left.  This will open your "Macro Manager"  
   
￼ 

 
 

In the Macro Manager, click on the "Macro set" 
dropdown and highlight one of your custom macro 
sets as shown on the left.  Next, on the Macro 
Manager toolbar, click on the "Save As" button and 
navigate to a to the flash drive where you saved 
your Logbook backup. 
 
The default name will be "DMMacroDefns", which 
you will need to change to some other unique name 
to indicate what the macros are used for.  Do this 
same process for EACH of your custom macro 
sets.  Each file will be saved as a .XML file in the 
location you have chosen.  
 
You need to follow this same procedure with EACH 
custom macro set you have created.  

 

Other DM-780 Settings  
Again, in the DM-780 Program Options, select the Soundcard, PTT and Modes + IDs options 
and either take screenshots or write down the settings so you will have them and can in most 
cases restore them on the new computer. 
 
You’re now ready to move the flash drive to the NEW computer and proceed restoring your 
Logbook and Macros to the new system using the tools provided in HRD. 
 
Use the Restore function in the Logbook Backup menu to navigate to and restore your logbook.  
Use the "Load" function in the Digital Master Macro Manager to restore your saved macros 
back into Digital Master. 
 
Following these procedures is also a good way of keeping current backups of all your important 
configurations in HRD. 
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Chapter 6 

 

Introduction 

 
Used to define various Ham Radio Deluxe features, Program Options can be selected in three 
different ways: 
• From the menu bar, select Tools > Program Options at the bottom of the list. 
• Press F8 
• Press the     Options icon on the toolbar. 
Most users will find that they can live with the defaults that can be modified in this dialog. 
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Keyboard Accelerators 
 

 
 

Define accelerators for use with the Keyboard or with programmable interfaces such as the 
Griffin Powermate.  When you press Add the definition window is displayed. 
  

 
 
Keyboard combinations are assigned to display buttons and arrow keys. As an example, we will 
assume that we want tot assign the key combination Ctrl+Alt+W to the Tune button. To do this 
we would do the following steps: 
 
1. In the Key field we would enter the letter W. 
2. Place a check mark in the boxes preceding Alt and Ctrl. 
3. In the text box below HRD Button enter the word Tune. 
4. Press OK to save your new accelerator. 
 
You will now see your new accelerator listed. 
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Comms 
 

 
 

Normally you will not have to change the default settings. 
• Read timeout – serial port timeout. 
• Switch off – some radios such as the FT-817 or the Kenwood TS-2000 can be powered down 
using a CAT command. If this option is selected you are prompted to switch off the radio. 
• Polling – to reduce CPU load for slower systems. 
• Dual VFO tracking – if selected both VFO's are tracked on every refresh. Only of use with 
Satellite Tracking. 
• Refresh interval – the interval between consecutive refreshes of the display. 
  

COM Port TX 
 

 
 

Some early ICOM radios do not support switching between TX and RX using CAT commands. The only 
way to enable computer controlled TX/RX this is by toggling a COM port pin. 
You require a special CAT cable if you select this option. 
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ICOM Calibration 
 

 
 

ICOM radios return a S Meter value between 0 and 255, normally 0 is S0, 12 is S1 and so on. As 
a S Meter unit is 6 dB the algorithm applied is to divide the returned value by two to get dB, 
then divide dB by 6 to get S units. 
 
Some radios such as the IC-706 have a different logic – use the Offset and Scale values to 
adjust the returned values so that the S Meter in Ham Radio Deluxe cor- responds to the S 
Meter on your radio. 

Internet 
 

 
 

Ham Radio Deluxe is able to detect whether you have an Internet connection with Internet 
GetConnectedState(). Uncheck this option if you do not want Internet access. 
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Out Of Band 
 

 
 

If you like to know where your band limits are when you are scrolling through a band and not 
watching the frequency window you can enable the optional sound files played when you tune 
in / out of band. You also have the ability to use a sound file of your choosing. 

Mouse Wheel 
 

 
 

You can define the tuning step when rotating the mouse wheel over the active tuning bar here. 
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Selection Window 

 

 
 

Defines options affecting the appearance and operation of the selection window. 
• Single-click – normally the Favorites tree folders are opened / closed with a double-click. 
Check this option to enable single-click operation. 
• Show numeric value – the Select Windows Advanced slider values are optionally 
superimposed on the slider. 
• Show the Options icon – historical support for the version 2 Advanced slider look and feel. 
 

Themes 
 

 
 
Docking panes are used for optional windows such as: Bandscope, Calendar, DX Cluster, 
Logbook, Selection, Shortwave Database and WinKey. 
 
Main Theme 
Select whichever visual theme you want – Office 2003 is an acceptable default. 
 
System Theme 
When you select Office 2003 or Windows XP for Menus and Toolbars you can select an 
optional System theme. 
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Main Tabs 
If you have more than one main window open – for example Radio and Logbook 
– then the main tabs are a useful way of switching between windows. 
 

 
 

Main tabs can be toggled On / Off by selecting from the Menu Bar View> Main Tabs. 
  

Updates 

 
 
Select how frequently Ham Radio Deluxe reminds you to check for new updates. 

Yaesu 

 
 

Special options for Yaesu radios. Due to firmware "features" in the FTDX-9000 it is necessary 
to wait up to 250ms after writing a command to the radio. With any luck Yaesu will fix this at 
some date in the future. 
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Chapter 7 
 

Introduction 
This chapter provides information on the Tools Menu.  There are many different options in this 
menu to test, configure and increase the functionality of HRD in your shack.  

HRD Archive Utility 
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                          
This option is very helpful if you are wanting to keep backups of your ALL the HRD data files. It's also hel                    
computer to the other.  This operation will also work if you are upgrading from V5.x to V6.x.  The only dif                   
when you use the Archive utility, it will automatically pick the proper FROM folder when creating the arc  
 
NOTE: If you plan to use the following methods to move HRD from one computer to anoth                 
BEFORE moving the file folders to the new machine. 
 
Note:  We also recommend you make an XML backup of your logbook to a flash drive or ot                 
make sure you make backups of EACH logbook before starting.   
 
If you are not familiar with creating the XML backup files, please see our tutorial video on         
 
HRD Logbook Backup - Recovery:  https://www.youtube.com/watch?v=Py4vvj1bRZk  
 
On the Rig control menu bar, click on Tools and select Archive from the drop-down menu. 
 

 
 

This dialog box allows you to create a full archive of your HRD data folders and also creates a 
backup of all the Registry Keys used by Ham Radio Deluxe. This option comes in handy in the 
event you have a hard drive crash and have to re-install your software. 

 

https://www.youtube.com/watch?v=Py4vvj1bRZk
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The From HRD Settings Folder: folder is automatically selected in the utility window.  Since the "Mig               
C:\users\<user name>\AppData\Roaming\HRDLLC\ 

 
The To Archive Folder: folder is user selectable. It's recommended you choose a location 
not on your main drive, such as a flash drive or external hard drive.  The flash drive is 
recommended if you are transferring your settings to a new installation on a different 
computer. 

 
Once these items are selected, click the Copy button at the bottom of the window and your 
archive will automatically be created.  Once the copy is complete, check to make sure you have 
got ALL the folders and settings transferred to your destination by opening the destination 
folder and check to see if the location looks similar to the one in the image below. 
 

 
 
HRD Archive Directory 

 
Once the archive has been created in the location you specified, you can go to that location to 
see you now have the HRD Data folders, which contain all your HRD data and settings, 
including your logbook database and default backups, and a Registration file. 

 
If you have created this archive on media you can move from computer to computer, you can 
now transfer your DATA folders from one computer to another. 

 
On the second computer, just do a default installation of Ham Radio Deluxe, so that it installs 
all the registry entries and creates all the data folders required. Once that is done you can take 
this archive to the second computer and OVERWRITE the default data folders. 

 
WARNING: Do not copy the registry file from one operating system to another. 
You could cause damage to your system to where it will no longer bootup and 
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operate properly. These files should be deleted from your archive. 
 
If you are setting HRD up on a second computer having Windows 7, Windows 8, or Windows 
8.1 or Windows 10, the HRD default data folders are located in the following location. This is 
where you would copy the folders from your archive. 

 
C:\users\<user name>\AppData\Roaming\HRDLLC\ 

 
NOTE: This folder is usually a "HIDDEN" folder, by default, in the Windows 
operating system.  To unhide this folder, open your Control Panel and select 
Folder Options. When Folder Options opens, click on the VIEW tab at the top of 
the dialog. Find the option that says "show/hide files and folders" and click the 
radio button that allows your system to "show hidden files,folders and drives".  
Click OK and close out to your desktop. 
 
Now, you can copy and past the folders from your archive media to the HRDLLC folder.  Once 
this is done, run the HRD software.  You may have to re-connect to your radio but when 
everything else starts, you should have your customized layouts, logbook and macros restored 
just as they were on the old computer. 
 
If you have any problems with this procedure, don't hesitate to contact the HRD support team 
for assistance. 

Add Desktop Icon 
 
This option is self-explanatory.  It adds the HRD Icon to your desktop.  This can be used in the 
 Event the installation does not create the correct icon on your desktop. 
 

Audio Grabber 
 
The audio grabber stores incoming audio in MP3 files using the MP3 tags to store information 
about the radio settings (or any other information you feel to be important). 
 
An alternative to MP3 would be Windows Media format (WMA) but the programming of WMA 
files is rather complex. 
 
To display the audio grabber select Audio Grabber from the Tools menu. 
 
By default the Audio Grabber is docked at the bottom of your Ham Radio Deluxe Screen. By 
grabbing the top bar o the Audio Grabber you can undock it and make it a separate window. To 
dock the double-left-click the "header" of the of the Audio Grabber and it will pop into place in 
the Logbook screen. 
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Recording 
 

 
 
Here you have the standard recording buttons. From left to right: 
 
• Record, 
• Stop, 
• Reset current recording, 
• Restart (close current file first), 
• Browse for MP3 files. 
 
You also set a file limit – a downside of MP3 is that the tags are written at the end of the file 
when it is closed, so to avoid losing information in the event of an unex- pected event it is best 
to use more, smaller files. 
 
We will now explain the different "TABS" across the top of the Audio Grabber screen. 

 

<-- Folder 

Here you select the folder where the MP3 files are stored. 
 

 

<-- Quality 
Here you select the bandwidth and quality. Modern 
computers have more than enough CPU power to 
support a very high quality. A bandwidth of 4.5 kHz is 
usu- ally acceptable unless you are recording a WFM 
broadcast. 

 

 

<-- Soundcard 
Select the soundcard that you are recording from. 

 

<-- Tags 
Here you see the values stored in the MP3 tags. To 
change the values just add the new text and then press 
Apply. 

 

Audio Browser 
 
Use the audio browser to playback MP3 files. To open the Audio Browser, select Audio Browser from the T                   
Audio Grabber. 
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MP3 Player Options 
 
Select MP3 player – a basic MP3 player is built into Ham Radio Deluxe, by clicking the "Pla             
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Use the From and To slider positions to select the part of the file to repeated over and over and 
over again. This is useful for determining exactly what the station was sending. 
 
 
 
 

Bandscope (Icom) 
 

 

This tool allows you to set the Bandscope edges for 
the IC-7800 transceiver.  This is for control of the 
Bandscope within the radio itself and does NOT 
display a Bandscope on the computer GUI. 
 

 

Bandscope  
 
Bandscope - Scans a defined frequency range in selectable steps and displays a graph of S 
Meter values (vertical axis) against frequency (horizontal axis).   

  
   
The current frequency range is displayed in the horizontal axis legend across the bottom of the 
graph. S Meter values are shown in the vertical axis legend at each end of the graph detail. The 
step size and user-selectable buttons are displayed at the left.  
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A vertical frequency marker will move across the bandscope display as the scan progresses. 
Frequency and band position displays in the main program window will also update in real 
time.  
   
Two colours are used in the display. Past scans are displayed in sample-and-hold fashion in the 
background colour - blue in this case. The current scan is superimposed over the top - green in 
this case.  
   
A fresh scan adds the most recent scan to the background detail building up a total activity 
display over time.  
   
A left mouse click anywhere within the bandscope window will tune the radio to the frequency 
of the position clicked.  
   
It is essential to use a fast AGC characteristic when using the bandscope. If the AGC is too slow, 
there will be a distorted signal display. As the data is based on S Meter values, slow attack 
times will have a delayed response and long hang times will show a gradually diminishing 
signal over a far wider frequency span.  
   
ATUs that may respond to frequency changes should also be disabled.  
 
Control Buttons:  

  
- commences a scan in the Up direction.  

   
- commences a scan in the Down direction.  

  
- stops the current scan.  

   
- clears the current values from the bandscope display window.  

   
- applies the band limits of the currently selected band to the bandscope scan range.  

   
- opens the Bandscope Options window.  

   
- saves the current bandscope image to a bitmap file.  
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The Options window is for manually customising the bandscope scan.  
   
From: - Enter the upper or lower limit of the required scan. The  

  
button will drop the frequency from the main program display into the input box.  
   
To: - Enter the remaining limit of the required scan. The  

  
button will drop the frequency from the main program display into the input box.  
   
The  

  
button will drop upper and lower frequency limits into the From and To boxes, based on the 
current bandwidth selection in its drop down listbox. The frequencies will be rounded. The 
entries in this example will be 2.5kHz either side of the current tuned frequency. Selections 
from +/-2.5kHz to +/-250kHz are available.  
   
Track band - If this option is checked, a single click on a frequency band bar on the main 
program display will cause that band to be included in the scan.  
   
Info popup - If this option is checked, and the mouse cursor is placed inside the bandscope 
window, information relative to the frequency immediately below the cursor will be displayed 
at the top of the window.  
   
Step size - This drop down listbox provides a scan step size selection from 100Hz to 
25,000Hz.  
   
Repeat - This drop down listbox provides the selection of either a continuous scan or once 
only.  
   
- This button needs to be pressed in order to apply any changed parameters to the scan.  
   
- If your radio can return data without actually scanning, you can use this feature. You will be 
advised if the function is not supported.  
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Browsers 
 
This option is self explanatory.  It allows you to open as many as 6 Internet Explorer browser 
windows.  There is also one browser that can be configured to automatically go to the QRZ.com 
website to lookup callsigns. 
 

Calendar 
 

 

Clicking on "Tools > Calendar" opens the HRD Event                   
anything you would like to keep a reminder handy fo    
 
Along the top of the calendar display is a small toolba                   
 
This is quite a useful utility for those who schedule a l         
 

 

Command Tester 
 
USE THIS DISPLAY AT YOUR OWN RISK 
 
This display is used to test CAT commands outside of the main Ham Radio Deluxe framework. 
The results can be saved to a text file for later analysis. 
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Connection 
---------- 
Select the type of command to be sent, Elecraft, ICOM CI-V, Kenwood, Ten Tec or Yaesu. 
 
The logic and fields are the same as those in the main HRD Connect window. 
 
Command 
------- 
 
Title 
----- 
Enter a title for the test - for example 'Read Frequency'. 
 
Codes 
----- 
Enter the codes for the command, then press 'Send'. Refer to your handbook for CAT command 
descriptions. 
 
Example: ICOM CI-V - Read Frequency 
----------------------------------- 
 
From .: E0 (The PC has address E0) 
To ...: The CI-V address of your radio, for example the IC-703 is 68. 
Cmd ..: 03 
 
Example: ICOM CI-V - Set Mode to USB 
------------------------------------ 
 
From .: E0 (The PC has address E0) 
To ...: The CI-V address of your radio, for example the IC-703 is 68. 
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Cmd ..: 06 
Sub ..: 01 
 
Example: Yaesu - Read Frequency and Mode 
---------------------------------------- 
 
P1 .....: 00 
P2 .....: 00 
P3 .....: 00 
P4 .....: 00 
Opcode .: 03 
 
Example: Yaesu - Set Frequency 14.234.560 MHz 
--------------------------------------------- 
 
P1 .....: 01 
P2 .....: 42 
P3 .....: 34 
P4 .....: 56 
Opcode .: 01 
 
Example: Kenwood TS-2000 Read VFO A Frequency 
--------------------------------------------- 
 
Cmd .......: FA; 
+ .........: none 
Wait for ..: ; 
 
Send 
---- 
Sends the command to the radio. 
 
Erase 
----- 
Clears the display 
 
Save 
---- 
Saves the display to a text file. 
 

DDE Monitor 
 
Ham Radio Deluxe uses dynamic data exchange (DDE) for inter-process communication. DDE 
allows two or more applications running simultaneously to exchange data and commands. 
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Select DDE Monitor from the Tools menu to display the supported DDE items. 
 

 
 
Commands 
The commands below are supported by Ham Radio Deluxe. 
 
Add ADIF Record 
         ADIF <data> 
Adds a record to the logbook; the record is supplied in ADIF format. Used by PSK31 Deluxe. 
 
Refresh 
       REFR button_status 
Refreshes all buttons. 
      REFR dropdown_list 
Refreshes all dropdown. 
 
Set Button 
      BUTN button_title=value 
Sets a button state. For normal buttons the value is either on or off. 
If title starts with @ then it's a dropdown, the value must be a dropdown value. 
 
Set Dropdown 
      DROP button _title=value 
Selects a dropdown value. 
 
Set Frequency 
      FREQ <hertz> 
Sets the frequency to the value supplied in Hertz. 
 
Set Mode 
      MODE <mode> 
Sets the mode to the supplied value. 
 
Top Window 
      TOPW 
Makes the Ham Radio Deluxe the top-most window in the Z-order, in other words brings Ham 
Radio Deluxe to the front of your monitor. 
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LDG Electronic ATUs 
 

Lock Program 

 

 

Clicking on the "Lock Program" option actually LOCKS the display 
screen.  To unlock, click the "Unlock" button on the "Locked" display. 
 

 

Shortwave Database 

Wikipedia defines Shortwave listening, or SWLing, as the hobby of listening to shortwave 
radio broadcasts located on frequencies between 1700 kHz and 30 MHz. Listeners range from 
casual users seeking international news and entertainment programming, to hobbyists 
immersed in the technical aspects of radio reception and collecting official confirmations (QSL 
cards) that document their reception of distant broadcasts (DXing). In some developing 
countries, shortwave listening enables remote communities to obtain regional programming 
traditionally provided by local medium wave AM broadcasters. One estimate placed the 
number of shortwave listeners worldwide in the hundreds of millions. 

HRD has the ability to add a database of shortwave stations from all over the world.  When you 
select the "SW DATA" icon from the HRD Rig Control menu, the SW Database is displayed on 
the lower portion of the Rig Control screen. 

 

Clicking on an entry in the SW Database will automatically tune your radio to the selected 
frequency so you can receive the broadcast. 
 
HRD Software LLC does not supply the SWL database though.  The database used is a 
subscription type purchase with several options available and can be obtained from 
http://www.ilgradio.com/.  The price of the database is between $10 and $15, depending on 
which subscription option you select.  Once you make your purchase, you will be sent a link to 
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where you can download the database file to install in the HRD SW Data system.   
On the left side of the SW Database screen, clicking on the  icon will take you directly to the 
International Listening Guide website where you can register for which ever database option 
you wish.  Once you have registered and selected a database option, you will be sent an e-mail 
with a link to download the database file.  Once you have the database file, just save it into any 
folder on your computer. 
 

 

To install the database into HRD, click on the  icon on the 
left side of the SW Database screen.  The configuration window 
will open where you can navigate to where you saved the file by 
clicking on the button indicated by the red arrow, and select it 
to be displayed.  Make sure you have a check in the "Enable" 
box so the DB will display properly. 

 

 

Clicking on the  icon opens the search filter window.  You 
can enter options in the filter to display specific records in the 
SW Database window. 

 
 
The  icon allows you to increase (+) or decrease (-) the text size displayed in the SW 
Database window. 
 

Transverter 
According to Wikipedia - Transverters are used in amateur radio to convert radio transceivers 
designed for use on the HF or VHF bands to operate on even higher frequency (microwave) 
bands. A transceiver used in this fashion is referred to as an IF radio, indicating its role as the 
"intermediate frequency" stage in the chain of radio electronics. Common 
transceiver/transverter combinations include transverters for 50 MHz, 70 MHz, 144 MHz, 222 
MHz, and 432 MHz designed for use with 28 MHz IF radios, and transverters for 50 MHz, 902 
MHz, 1296 MHz, 2304 MHz, 3456 MHz, 5706 MHz, and 10368 MHz designed for use with 
144 MHz IF radios. Some transverter units include transmit/receive switching built into the 
design, whereas other units require external switching. The use of external switching is popular 
in applications where preamps and amplifiers are included. Many transverters are built into 
waterproof enclosures for installation on a radio tower or other antenna support structure to 
get the device as close as possible to the antenna so as to reduce signal loss in the transmission 
line. 

The High Speed Multimedia Radio article discusses the radio transceivers that use 802.11 
(WiFi) with the transverters to achieve Wireless Broadband communication in the frequency 
bands reserved for Amateur radio operators. 

HRD Transverter - Provides management of offset frequencies for transverter use. The Offsets 
button provides for the entering of any offset frequencies for transverter use as well as the 
algorithm for computing the frequency and the display at left will indicate the calculated 
transmit frequency. 

https://en.wikipedia.org/wiki/Amateur_radio
https://en.wikipedia.org/wiki/High_frequency
https://en.wikipedia.org/wiki/Very_High_Frequency
https://en.wikipedia.org/wiki/6_meters
https://en.wikipedia.org/wiki/4_metres
https://en.wikipedia.org/wiki/2_meters
https://en.wikipedia.org/wiki/1.25_meters
https://en.wikipedia.org/wiki/1.25_meters
https://en.wikipedia.org/wiki/70_centimeters
https://en.wikipedia.org/wiki/33-centimeter_band
https://en.wikipedia.org/wiki/33-centimeter_band
https://en.wikipedia.org/wiki/23-centimeter_band
https://en.wikipedia.org/wiki/13-centimeter_band
https://en.wikipedia.org/wiki/9-centimeter_band
https://en.wikipedia.org/wiki/5-centimeter_band
https://en.wikipedia.org/wiki/3-centimeter_band
https://en.wikipedia.org/wiki/Preamp
https://en.wikipedia.org/wiki/Amplifiers
https://en.wikipedia.org/wiki/Radio_masts_and_towers
https://en.wikipedia.org/wiki/Antenna_(radio)
https://en.wikipedia.org/wiki/Transmission_line
https://en.wikipedia.org/wiki/Transmission_line
https://en.wikipedia.org/wiki/High-speed_multimedia_radio


HRD Rig Control V6.3          Copyright © 2016 HRD Software LLC         

 

91 

 

 

 

HRD Transverter - Provides management of 
offset frequencies for transverter use. The 
Offsets button provides for the entering of any 
offset frequencies for transverter use as well as 
the algorithm for computing the frequency and 
the display at left will indicate the calculated 
transmit frequency. 

 

 

Clicking on the [Offsets] bottom on the Transverter 
display opens the Offsets window where you can 
select, add, edit or remove your offsets. 

Tune-Up 
The "Tune-Up" utility allows those who do not have an automatic tuner the ability to tune t 
heir antenna using their external antenna tuner.   

 

 

Two modes of operation are offered, you can use the 
Continuous or timer when the tune-up is activated.  A mode 
selection drop box is also provided to select a mode you wish 
to use when you tune your antenna.  In most cases, the "AM" 
mode is selected, since this automatically reduces the RF 
output of your transmitter to 25 watts.  If you use CW or 
other mode to adjust your antenna tuning, an RF Power 
slider is provided to adjust the power to a lower output for 
the tuning process.  Once configured, click the [Start] button 
and your transmitter will key to allow you to adjust your 
tuner.  You can set the timer to keep the radio keyed for a 
specific time, or, if set to the "continuous" mode, you just 
click the [Stop] button once you have your adjustments 
made. 

 

External Dial Control 

Programs 
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The "Programs" tool gives you options to run the other HRD modules and includes a 
configurable 3rd party Program Launcher, which allows you to configure 3rd party software, 
which you can run concurrently with HRD, to be launched from within the HRD Rig Control 
Screen.  The Program Launcher can be quite useful for those who run 3rd party software in 
conjunction with HRD.  Using this utility makes it easy to launch those programs without 
having to minimize the HRD screen and go looking for the icon to click.  Just click on the 
program launcher, select the program you want to run, and off you go. 
 
Adding software to the Program Launcher is quite simple. 
 

 

Click on the icon indicated by the arrow (#1) in the 
top image on the left.  This will open a second 
window shown below on the left.  Click on the 
Navigation button (#2) and navigate to the location 
of and select the ".exe" file you wish to launch.  Then 
enter a brief title in the "Caption" field for the file 
and click the "OK" button.  
 
This will add the caption to the Program Launcher 
dialog and a single click on that title will launch the 
program. 

 

Hardware 

IP Server 
 
This IP Server is HRD's internal server used to allow all the modules within the suite to 
communicate with each other on the "local" computer.  The configured port used is Port 7809 
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and should NOT be changed unless you are familiar with the HRD system. 
 
If you find the modules within HRD are not communicating with each other, you need to check 
this server option to make sure it has started and is running.  This server starts automatically 
when opening the HRD software. 
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Webpage Updates 
This little utility is for those of you who have a website and would like to keep your users 
informed of your ham radio activity.  This allows you to schedule real-time uploads via FTP, to 
a page on your website that shows the Frequency in MHz, Mode, what Radio your operating 
from and the current date and time for your current ham activity.  This allows visitors to your 
website to see where you are operating and will allow them to try to contact you via radio. 
 

 
 
 
To maintain a web page with your current HRD activity you must first create a template web 
page with tokens (below) which are replaced with values from HRD. The supported tokens are: 
 
    ###-frequency-### - frequency in MHz, 
    ###-mode-###      - mode, 
    ###-radio-###     - radio, 
    ###-timestamp-### - current date and time. 
 
The sequence of operations is: 
 
    1: A copy of the template web page is made, 
    2: The tokens are replaced with the HRD values, 
    3: The copy is then uploaded. 
 
The uploaded file has the same name as the template page. 
The upload uses FTP or, if you specify the Host name as local, the file is copied into the 
directory.  
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To use FTP you must specify your remote FTP directory access information (username and 
password). 
 
    Host name - the FTP host name, 
    Directory - the optional remote directory, 
    User ID   - the user id for accessing the site, 
    Password  - the password for accessing the site. 
 
Select the update interval with the auto-update options. 
Press 'Test FTP' to test the FTP definition and upload a new webpage. 
Press 'Preview' to display the new webpage without uploading it. 

Extended Menus 

Memory Management 

HRD Global Settings 
The HRD Global Settings is accessed by clicking on "TOOLS" on the main menu of each of the 
5 main HRD software modules, then selecting the HRD Global Settings option. 

 
Clicking on the icons on the left side of the Global Settings dialog allows you to set options and 
perform some tasks related to the operation of HRD.  Below are a list of the various tasks and 
options available in the Global Settings.  These settings are pretty much self-explanatory as far 
as what they are used for and how to use them.  We will just give a brief description of each of 
the setting categories. 
     

● Mode:  This option allows changing the global settings within HRD from displaying 
BASIC settings to displaying more advanced options in the menu systems.  Most users 
prefer to use the "advanced" setting on the slider since this setting allows you to view 
and adjust some settings that are otherwise not visible in some of the menus when set to 
the basic setting.   

● Preferences:  This option allows you to select your preferences for how distances are 
displayed in miles or kilometers and sets temperature readings either to Celsius or 
Fahrenheit.   
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● Database Version:  Displays what logbook database versions you have installed on 
your computer.  There is also a utility to transfer the database from one HRD version 
into the current version.  

● Auto-Update:  This option allows you to update the Country List and Unique Callsign 
Database within HRD automatically or manually.  NOTE: Due to the fact the Country 
List and UCSDB requires someone to monitor and update the database as changes are 
made, this feature expires along with your Support and Software Maintenance 
Agreement.  In order to keep this feature up to date, after your first year, you must 
renew your Support Agreement on an annual basis. 

● Country Nodes: 
● Version:  This dialog is primarily for the support staff use.  It shows the main Dynamic 

Link Libraries associated with the HRD software, the released version, date and time the 
release was compiled and performs the validation for the HRD installation. 

   

Program Options 

Used to define various Ham Radio Deluxe features, Program Options can be selected in three 
different ways: 

• From the menu bar, select Tools > Program Options at 
the bottom of the list. 

• Press F8 

• Press the    Options icon on the toolbar. 
Most users will find that they can live with the defaults that can be 
modified in this dialog. 

Keyboard Accelerators 

 

Define accelerators for use with the Keyboard or with programmable interfaces such as the Griffin 
Powermate. 
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When you press Add the definition window is displayed. 
 

 
 
Keyboard combinations are assigned to display buttons and arrow keys. As an example, we will 
assume that we want tot assign the key combination Ctrl+Alt+W to the Tune button. To do this 
we would do the following steps: 

1 In the Key field we would enter the letter W. 
2 Place a check mark in the boxes preceding Alt and Ctrl. 
3 In the text box below HRD Button enter the word Tune. 
4 Press OK to save your new accelerator. 

You will now see your new accelerator listed. 
 

 
 
 

Comms 

The Ham Radio Deluxe menu has pre-assigned accelerators; these cannot be rede- fined. These are 
listed in the Reserved window. 
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Normally you will not have to change the default settings. 

• Read timeout – serial port timeout. 
• Switch off – some radios such as the FT-817 or the Kenwood TS-2000 can be 

powered down using a CAT command. If this option is selected you are prompted to 
switch off the radio. 

• Polling – to reduce CPU load for slower systems. 
• Dual VFO tracking – if selected both VFO's are tracked on every refresh. Only of use 

with Satellite Tracking ( Satellite Tracking on page 209). 
• Refresh interval – the interval between consecutive refreshes of the display. 

 

COM Port TX 
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ICOM Calibration 

Some early ICOM radios do not support switching between TX and RX using CAT commands. The 
only way to enable computer controlled TX/RX this is by toggling a COM port pin. 

You require a special CAT cable if you select this option. 
 

 
ICOM radios return a S Meter value between 0 and 255, normally 0 is S0, 12 is S1 and so on. As a S 
Meter unit is 6 dB the algorithm applied is to divide the returned value by two to get dB, then 
divide dB by 6 to get S units. 

Some radios such as the IC-706 have a different logic – use the Offset and Scale values to adjust 
the returned values so that the S Meter in Ham Radio Deluxe cor- responds to the S Meter on your 
radio. 
 

Internet 

 

Ham Radio Deluxe is able to detect whether you have an Internet connection with Internet 
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GetConnectedState(). Uncheck this option if you do not want Internet access. 
 

Out Of Band 

 

If you like to know where your band limits are when you are scrolling through a band and not 
watching the frequency window you can enable the optional sound files played when you tune in / 
out of band. You also have the ability to use a sound file of your choosing. 
 

Mouse Wheel 

 
You can define the tuning step when rotating the mouse wheel over the active tun- ing bar here. 
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Selection Window 

 
Defines options affecting the appearance and operation of the selection window. 

• Single-click – normally the Favorites tree folders are opened / 
closed with a double-click. Check this option to enable single-
click operation. 

• Show numeric value – the Select Windows‟s Advanced slider 
values are optionally superimposed on the slider. 

• Show the Options icon – historical support for the version 2 
Advanced slider look and feel. 

 
 
 

Themes 

 
Docking panes are used for optional windows such as: Bandscope, Calendar, DX Cluster, Logbook, 
Selection, Shortwave Database and WinKey. 
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Main Theme 
Select whichever visual theme you want – Office 2003 is an acceptable default. 

System Theme 
When you select Office 2003 or Windows XP for Menus and Toolbars you can select an optional 
System theme. 

Main Tabs 
If you have more than one main window open – for example Radio and Logbook 
then the main tabs are a useful way of switching between windows. 
 

 
Main tabs can be toggled On / Off by selecting from the Menu Bar View> Main Tabs. 
 

Updates 

 
 
 

Yaesu 

Select how frequently Ham Radio Deluxe reminds you to check for new updates. 
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Special options for Yaesu radios. Due to firmware "features" in the FTDX-9000 it is necessary to 
wait up to 250ms after writing a command to the radio. With any luck Yaesu will fix this at some 
date in the future. 
 
 
 

Serial Port Client 
 
Select Port Client from the Tools> Programs menu. 
 

 

You must define the serial port mappings 
before you connect to the serial port server 
running on the remote computer. 

 
Press Add to define a new mapping. 
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Each mapping consists of: 
•  Title – whatever makes sense to you. In this case we're mapping to a K1EL WinKey on 
Simon's remote station in the south pacific. 
•  The local port – one of the virtual null modem ports. Here the two ports are COM20 and 
COM21. 
•  The remote port – Simon has connected the WinKey to COM1 on the remote computer. 
•  Remote port settings – WinKey uses 1200,8,none,1. 
•  [X] Enable DTR and [_] Enable RTS – usually checked to provide power to a special powered 
cable or device. For Winkey you must check DTR to provide power to WinKey! 
  

Remote Port Settings 
Some useful remote port settings are: 
• WinKey – 1200,8,none,1 and [X] Enable DTR. 
• AlfaSpid RAS rotator – 600,8,none,1. 
• AlfaSpid RAS rotator – 1200,8,none,1. 
• Idiom Press rotator – 4800,8,none,1. 

 
Press Connect to connect to the serial port server on the remote computer. 
 

In the Connect to field enter the remote address, 
for example 201.42.12.246. If you are not using 
the default port (7806) then append a colon and 
the port number, for example 201.42.12.246:7808 
to connect to port 7808 on 201.42.12.246. 

In the Username and Password fields enter the 
username and password you have been given; 
these must also be entered in the configuration 
file. 
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When you have finished just press Connect. 

Assuming everything works correctly the client 
will display log information similar to that below: 
 

 

The client makes two connections; one to send 
data, the other to receive data. The remote server 
returns a list of known serial ports after the first 
connection is established, in this case COM1, 
COM3, COM4, COM5 and COM6. 
Now check the Simon's WinKey mapping and you 
see logfile messages as the local (COM20) and 
remote (COM1) serial ports are opened. 
 

 
Now you can connect to the remote 
WinKey using COM21 (the other 
half of the COM20 <-> COM21 
virtual cable). 
If you enable Tracing you see the 
data sent and received as the 
WinKey code runs through the 
initialization and performs an 
echoback test. 

 
 

 

    
Congratulations – you can now use your remote WinKey. 
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Voice Functions 
 
This feature is quite useful for those who are visually impaired.  Clicking "Voice" on the main 
menu allows the HRD Rig Control to announce various functions on the display.  When you 
Voice, a dropdown menu will appear. 
 

 

Voice announcements can then be activated or de-activated by checking 
the "Enable" function or by using the Ctrl+Alt+V keyboard shortcut.  
Pressing the Shft+Fey combinations indicated will announce the selected 
item.  If you check the "Speak Tool tips" this announces the tool tip pop 
ups. 
 

 
 

Synchronizer 
 
The synchronizer is used to control two or more radios where a common fre- quency is shared 
by using the Dynamic Data Exchange (DDE) mechanism.  For each radio you are using you 
start an instance of Ham Radio Deluxe, one instance is the Master, the rest are the Slaves, the 
slaves receive frequency and mode information from the master. 
 
Start the Synchroniser from the Tools> Programs menu, then press Scan to find the active 
Ham Radio Deluxe instances. 
 

 
Select the master instance (supplied the frequency and mode), and then press Start. 
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In the Frequency and Mode dropdowns you select the corresponding source from the Ham 
Radio Deluxe master instance: 
• Radio – as seen on the main Ham Radio Deluxe display, 
• Transverter – frequency is taken from the Transverter window (selected from the Tools 
menu). 
• Satellite uplink – the uplink frequency and mode (see Ground Control on page 213). 
• Satellite downlink – the downlink frequency and mode (see Ground Control on page 213). 
In the Ham Radio Deluxe Slaves group box check the instances to be controlled by the 
Synchroniser. 
As soon as you check a slave the slave‟s frequency and mode are updated with the current 
values from the master; every time the master frequency and / or mode change they are sent to 
the slave for so long as the slave option remains checked. 
 
If you are using two radios for satellite tracking (for example two FT-817 or IC- 7000): 
1. Start an instance of Ham Radio Deluxe for each radio; connect to the radios. 
2. Select an instance to use as the master, in this example the radio used for receive. 
3. In the master (receive) instance: 
• Start the display. 
• Enter transmit and receive frequency information for the satellite you are tracking. 
• Check the RX VFO, do not check a TX VFO as this instance will not be used for transmit. 
4. Start the Synchroniser: 
• Master is the receive instance, 
• Slave is the transmit instance, 
• Select the Satellite uplink option for Frequency and Mode so that the slave receives the 
frequency and mode used for transmit as computer by the Master instance. 
 
The slave will now be updated with the transmit frequency and mode for transmit every time it 
changes in the master instance. 
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Chapter 8 

 

Selection Menu Options 
 
Clicking the "Selection" icon on the Rig Control main menu opens the "Selection" option panel 
on the  
right side of your display.  This panel contains many configuration options and utilities that are 
commonly used when controlling your radio.   
 
The main feature options controlled from within the Selection menu are Bands, Favorites, Quick Save, 
Advanced, Macros and Menus.  Most of these selections also contain managers for the options within 
the feature so you are able to configure the option to  your liking.   
 
Other options in the "Selection" pane, allow you to control menu items within the radio's menu 
system, that are available from the CAT functions but do not appear on the HRD Rig Control GUI. 
 
 

Favorites 
 

 

Due to limitations in the CAT system of most radios supported by 
HRD, the Memory functions are not available.  HRD has provided 
for this by having the "Favorites" option where you can store your 
favorite frequencies for nets, rag chew and other places where 
there is activity that interests you. 
 
The frequencies can be stored in a number of ways, by band, my 
mode by usage, or by just about any method you choose.  As you 
can see on the left, we have frequencies stored in folders which are 
named according to what frequencies are contained in each folder. 
 
At the very top of the list, you see the "Manager".  Clicking on the 
Manager opens the way for you to create folders and save your 
favorite frequencies when can then be accessed with the click of 
your mouse. 

 
Favorites Manager 

Start the manager from the Favorites menu or the Favorites pane in the Selection window. It is 
designed to be easy to use - let's see. 

 



HRD Rig Control V6.3          Copyright © 2016 HRD Software LLC         

 

109 

 

The Favorites Manager, as the name implies, provides a means to manage your favorite 
frequencies.  They can be grouped by Root folders by band, mode, topic or interest.  New Root 
folders are created using the "New Root" button.  Root folders can have sub folders to help 
further group your favorites.  These sub folders are created using the "New Folder" button.  
You add your favorite frequency using the "Add" button. 

 

Root folders and their associated sub folders can be turned on and off by checking or 
upchucking the box in front of the folders.  If for example you do not have an antenna for 
160m, you can uncheck the box in front of the folder and 160m will no longer be listed in the 
Favorites pane of the Selection window.  They will still be visible, however, in the band display 
above the 160m band. 
 

 
 

Manager Options 
New Root – create a new top-level (root) folder. Folders are not saved if they are empty (no child 
folders or definitions). An example would be a Root Folder labeled JOTA for Jamboree on the Air. 

New Folder – create a new folder as a child of the currently selected folder. An example would be 
to create a sub folder under JOTA labeled SSB or CW. 
Sort Folder – sort the entries in the currently selected folder: 

 By title, 
 By ascending frequency, or 
 By descending frequency. 

Add – add a new definition. If you have crated a new empty folder, you can not add a favorite 
frequency to it. You need to add the frequency to either a higher level folder or in a folder that has 
favorites in it. You can then move the new favorite to the new folder that you created earlier. 
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To add a new favorite frequency to an existing folder: 

● Click on the folder that yo  
wish to add a favorite to. 
● Click on Add. 
● Enter a title for your favo  
● Enter the desired frequen  

without the decimal point. 
If you are adding a frequency that starts with a single 
digit before the first decimal point, place your cursor 
immediately adjacent to the left side of the first digit. 
 

 
  
 

  

If you are adding a frequency that starts with two digits 
before the first decimal point, place your cursor a bit further 
to the left so there is a small space between the cursor and 
the leading zero. 

 
 
  
 

  

For three digits place your cursor a bit more to the left. 

• Select you operating mode. 
• Click on OK and your new favorite w   

saved in the selected folder. 
You can also select Add from Favorites in the menu bar to add a 
new defini- tion.You can also use Cntrl+A keystroke combination 
to access the add function. 
 

 
Del – delete the current folder or definition (depending on which you have selected). 

 

Move – move an entry to another folder (alternatively drag entries between fold- ers with your 
mouse). 

 

 
5 Highlight the folder or definition. 
6 Click on Move. 
7 Select the new folder. 
8 Click on OK. 
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Copy – make a copy of an existing definition. 

Edit – edit the selected folder / definition. 

Arrows – rearrange the selected folder / definition. 

Load – load a new set of definitions from a file previously created using Ham Radio 
Deluxe; all current definitions are discarded. 

Merge - merge definitions from a file previously created using Ham Radio Deluxe. 
Defaults – restore the default list (hard-coded into Ham Radio Deluxe). 

Save – save current definitions to a file. 

 

Favorites Markers 
To display your favorite markers in the Ham Radio Deluxe display select Show Markers from the 
Favorites menu. The marker size is selected from the Marker Size option in the Favorites menu. 

 

When you select to "Show Markers" they will be displayed on the 
tuning bar as shown on the left and a popup text is displayed as you 
move the mouse pointer over a marker. The text is constructed from t  
favorite title and frequency. 

 

 

Quick Save 
 

 

This is a simple way of marking a frequency as being 
interesting – you are moni- toring three QSO's with a single 
radio and you want to quickly switch between the 
frequencies – for example during a 6m sporadic-E opening. 

Each definition consists of the frequency in Hertz and mode; 
definitions are saved in the registry. 

To switch between Quick Save definitions use the 
accelerator key combinations for the Quick Save menu 
options Next (Ctrl+F5) and Previous (Ctrl+F6). 
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Add Entry 

 

If you are tuning around on your receiver and find a net or 
maybe a frequency that is very active and you would like to 
return to this frequency in the future you can quickly add the 
frequency to your Quick Save list by clicking on the "Quick 
Save" on the Rig Control toolbar, and click the "Add" option 
from the dropdown. 
 
In the future, if you want to return to this frequency, just open 
the Quick Save menu item in the "Selections" panel and click 
on the frequency that was added.  Your radio will 
automatically be tuned to that frequency. 
 
Later, if you decide you want to keep this in your "Favorites" 
you can add it to your Favorites option in the proper folder 
and will be able to select it from there and remove it from the 
Quick Start option. 

 

 

When a frequency has been added to the Quick Save menu, a 
marker, similar to the ones for your Favorites, will be created 
on the tuning bar of the RC screen.  When you move your 
cursor to that marker, it will indicate the 
"QS":"Frequency","mode" in a popup as shown on the left.  
Once you remove the frequency from your Quick Save menu 
either by deleting it or moving it to your favorites, the Quick 
Save marker will be removed from the tuning bar. 

Bands 
 
The bandmaps in this section actually serve two purposes.  They are setup to provide the frequency tuning                  
each band in the Rig Control GUI. 
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HRD comes preconfigured with several band choices available.  
Choosing any one of these options does a couple things.  First and 
most important, you will notice there are 3 selections for the 160m - 
10m bands.  This is due to the fact the world is divided into  3 IARU 
Regions.  These 3 regions are organized to broadly mirror the 
structure of the ITU and it's related regional telecommunications 
organizations.  Each region has a specific frequency range assigned 
for each of the amateur radio bands.  For example, 40m in Region 1 
allows you to operate in the frequency range of 7.000 MHz - 7.200 
MHz, while Region 2 allows a frequency range for 40m of 7.000 - 
7.300, therefore it's important you select the proper region when 
setting up HRD with your radio.  Below are the Regions. 
 
Region 1: Europe, Africa, Middle East and Northern Asia 
Region 2: The Americas 
Region 3: Asia-Pacific 
 
At the top of the Bands panel, you see the "Manager".  Selecting this 
will allow you to modify any of the preconfigured "bandmaps" or 
even create custom bandmaps of your choice. 

 

Band Manager 
The band manager can be used to either modify the currently configured bandmaps or you can 
create totally new bandmaps to suit your operating.  To open the band manager, click 
"Manager" at the top of the Bands panel. 
 

 

From the Band Layout Manager you can activate or de-
activate any of the bandmaps.  Upchucking the check on to 
the left of each bandmap will remove it from the Bands 
menu options. 
 
From this manager you can also create completely new 
bandmaps or, if you like, modify any of the default 
bandmaps to display any band or frequency you like. 
 
Each of the default bandmaps covers the full spectrum of 
frequencies for each of the amateur bands.  Many 
operators, who have a license which restricts the 
frequencies they operate on might want to EDIT one of he 
existing defaults so that if they by accident move out of 
band, the alarm will warn them. 
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Modifying A Bandmap 
The regional bandmaps are setup for mainly HF operation between 160 and 10 meters.  The 
next one that contains all of those are the 160m to 70cm.  Many HF radios have 6m on them, so 
how do we get a buttons for 160m to 6m?  Quite simply, by modifying the 160 - 70cm band 
map.  To do that, click on the 160 to 70cm bandmap to highlight it in the manager.  Then click 
on the "COPY" button at the top of the manager.  This opens a copy of that bandmap in the 
editor. 
 

 

With this bandmap open in the editor, first, we need to 
change the "Title" of it, so, change "Copy of 160m - 
70cm" to "160m - 6m" 
 
Next, in the lower screen where the different frequency 
ranges are, click on the 2m frequencies to highlight that 
line. Next, click the "Delete" button on the editor toolbar.  
Do the same with the 70cm frequencies, click to 
highlight, then delete. 
 
Now we have renamed this and want to save it to our 
Bands menu, so, some of you may find you don't have 
the [OK] and [Cancel] buttons at the bottom of the 
screen.  You may need to resize the Editor screen slightly 
by putting your cursor on the very bottom edge of the 
screen, click and hold the left mouse button, and drag 
downward just a very small amount and the OK and 
Cancel buttons will be shown. 
 
To save your newly modified, just click the [OK] button 
and the new band will be added to the bottom of the 
Band Manager.  Now, click the [OK] button on the Band 
Manager and the newly created bandmap will be saved 
under the bands menu. 
 
Now, just click on the newly created bandmap in the 
menu and your radio screen will show you now have 
buttons for 160 to 6 meters.  Clicking on each button will 
now set your radio to that band. 
 

 
You can easily use the above procedure to edit each band, for example, a General class license 
holder could modify the 20m band to provide 2 buttons on the radio with frequency ranges 
that covers ONLY the frequency ranges he is authorized to operate in.  One button could be 
setup to cover the "CW/Digital" portion of the band by creating a new frequency range, name 
the button "20m D" and entering the frequency range of 14.025 to 14.150, then create a new 
button "20m V" to cover the voice frequency range allocated to a General class operator, 14.225 
to 14.350.  Once created within the band plan, delete the normal 20m entry, save this new 
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bandmap and select it's button and those two new buttons will appear on the Rig Control GUI. 
 

Advanced 
 

 

This "Advanced" pane will NOT display on all of the HRD 
screens when the "Selection" option is opened.  This is 
available for ONLY radios that have full CAT control of the 
included options in this menu item. 
 
This options allows control and settings to many of the 
options already displayed on the radio's GUI in addition to 
many menu items within the radio's menu system that are 
NOT on the GUI, but still available from the CAT interface. 
 
If available, some menu items within your radio can be 
changed from here instead of actually opening the menus in 
the radio itself. 
 
Again, these options may not be available for ALL radios 
supported by HRD. 

 

Macros 
 

 

Ham Radio Deluxe supports two types of custom definitions: 

• CAT commands 
• User 

defined macros which are a 
combination of standard Ham 
Radio Deluxe input fields 

Macros are selected from the Macros pane in the Selection 
window. 
 

 

Cat Commands 
A CAT command macro is a command that you define yourself, containing one CAT commands as 
describer in your radio's handbook. The commands you enter must be supported by your radio. 

Use CAT commands to add support not provided by the Ham Radio Deluxe inter- face. 
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Manager 

 

To open the CAT Command macro manager do one of the 
following: 
• Press Manager in the Macros> C  

Commands selection pane 
• Select CAT Command Manager f  

the Macros menu 
 
This opens the CAT Command Manager as shown on the left. 
 

 

 

1 Press New to create a new comm  
definition. 

In this example a Kenwood command is defined for the TS-2000. 
The mode is set to USB and the frequency to 50.150 MHz. 

2 In the Title field enter [50.150 M  
USB]. 

3 In the CAT Command field enter  
following commands: 

   # Set mode to 
USB. MD2 

   # Set frequency to 50.150 MHz 
FA00050150000 

 
4 In the Description field enter 

[Change frequency to 50.150 MHz, mode to USB]. 
5 Click on OK. The new definition  

added to the list in the Manager window. 
  

  

Protocols Reference 
Each brand of radio has a slightly different protocol for their CAT commands. Below is are 
examples of the differences. For complete information, please refer to the operating manual for 
your radio. 

ELECRAFT AND KENWOOD 
Each command consists of two alphabetical characters (lower or upper case) and optional 
parameters. 

The terminating semicolon (;) is not necessary, it is added automatically. 

TS-480, TS-2000 

Set mode to LSB .....: MD1  
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Set mode to USB .....: MD2  

Set AF gain to 0 ....: AG0000  

Set AF gain to 100 ..: AG0100  

Select VFO-B ........: FT1 
You can define more than one command; to do this start each command on a new line. 

Special Commands 
Comment ..........: # Some interesting text. Pause of 250 ms ..: @ 250 

ICOM 
ICOM radios use the CI-V format to communicate with the radio. Please read your operating 
manual for command information. 

Each entry defined here consists of: 

• [1] command, 
• [2] optional sub-command and 
• [3] optional data. 

You must add a - between each byte (each byte is two hexadecimal characters). 

IC-7800 
Set mode to LSB ..........: 06-00 
Set mode to USB ..........: 06-01 
Set AF to 0 ..............: 14-01-00 
Select preamp 2 ..........: 16-02-02 
MOD I/P (data off) MIC ...: 1A-05-00-31-00 MOD I/P (data off) SPDIF .: 1A-05-00-31-
07 
You can define more than one command; to do this start each command on a new line. 

Special Commands 

Comment ..........: # Some interesting text. Pause of 250 ms ..: @ 250 

TEN-TEC 
In general Ten-Tec commands are two character commands followed by data and a carriage return 
<cr> or <0x0d>. Do NOT add the carriage return - this is added automatically. 
 
Some data must be sent in binary format, hexadecimal is used to represent binary data. To set 
Split mode on for the Argonaut the documented command is 
*O<0x01><0x0d> which is entered here as *Ox01, that is *O (Split mode) + x (switch to binary) + 
01 (Split On). The carriage return <0x0d> is not added. 
Please read your operating manual for command information. 

When you enter x the format switches to binary mode - two hexadecimal charac- ters per byte. 
Only enter x once, even if entering more than one byte of data. 

Argonaut 
Set mode to LSB .....: *M2  
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Set mode to USB .....: *M1  
Set split mode on ...: *Ox01  
Set split mode off ..: *Ox00 

Jupiter 
Set mode to LSB .....: *M2  
Set mode to USB .....: *M1  
Set AF gain to 32 ...: *Ux20  
Set filter to 450Hz .: *Wx1D 
You can define more than one command; to do this start each command on a new line. 

Special Commands 
Comment ..........: # Some interesting text.  
Pause of 250 ms ..: @ 250 

YAESU 
Starting with the FTDX-9000 Yaesu has changed the CAT protocol to one very similar to that 
used by Kenwood. So if you are fortunate enough to have the FTDX-9000 please use the Kenwood 
commands – See "Elecraft and Kenwood". 

Each Yaesu command consists of five bytes. The bytes are defined in the order in which they are 
sent to the radio. You must add a - between each byte. 

Each command consists of four bytes of data and an OpCode. The order in which P1-P4 are shown 
in your operating manual does not matter here - there are differ- ence between Yaesu radios, just 
remember that the bytes are defined in the order in which they are sent to the radio. 

FT-817 
Set mode to LSB ..: 00-00-00-00-07  
Set mode to USB ..: 01-00-00-00-07  
Set Split on .........: 00-00-00-00-02 

FT-1000MP 
Set mode to LSB ..: 00-00-00-00-0C  
Set mode to USB ..: 00-00-00-01-0C Split on .........: 00-00-00-01-01 
You can define more than one command; to do this start each command on a new line. 

Special Commands 
Comment ..........: # Some interesting text. Pause of 250 ms ..: @ 250 
 

 

User Defined Macros 

User created macros are combinations of fields on the Ham Radio Deluxe radio display. Users of 
Microsoft Office will be familiar with the concept supported here. When you start out you will see a 
Macros: Default sub tab in the Selection window. This name will / can change depending on how 
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you define your macros. You can also add more sub tabs allowing you to sort your macros in a 
manner convenient to your operating style. Let's do a couple of examples. 

 

Manager 
Select Manager from the Macros: Default menu, and then press New to create our first new macro. This 
macro will switch your radio to 50.150 MHz in USB.We will put it in a new sub folder called "Simple". 

First we will name the macro and where it will reside. We can then set the mode to USB: 

 

 

 
1 In the Title field enter [50.150 MHz USB]. 
2 In the Group field enter [Macros: Simple]. 
3 In the Description field enter [Change 

frequency to 50.150 MHz, mode to USB]. 
4 Click the "Add" button located just below the 

"Fields" display on the Macro Editor screen. 
 

 

 

After clicking "Add" in the previous step, the 
window on the left will open.  In this box: 
 
1. Put a tick in the "Dropdown Button" 
2. Click the dropdown box and select the 
"Mode" 
 
Upon completing these steps, click the "OK" 
button on the bottom of the window. 

 
At this point, you will be returned to the main Macro Editor screen where you will once again 
click the "Add" button to allow you to enter the "Frequency".  When the "Add" window opens 
(as shown in the last step) place a tick in the "Frequency" field as you did for the "Dropdown 
Button" previously, and enter the Frequency (50.150.000) in the field provided. 

 

You have nouw defined 2 fields as shown on the left.  Click the 
"OK" button at the bottom of the Macro Editor. 

Next, press the "Save" button on the Macro Editor Toolbar and close the window.  Your 
Macro will now appear in the Macro: Default pane. 
Another Example 

Following the above instructions, with the exception of just a few changes, we will create a new 
Macro inside a new folder. 
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This macro will switch your radio to 14.070 MHz in USB.We will put it in a new sub folder "PSK" 
 
1. Reopen the Macro Manager which now can be found in the Macro: Simple sub-folder. 
2.In the Title field enter [20M PSK]. 
3.In the Group field enter [Macros: PSK]. 
4.In the Description field enter [Tune radio to 20M PSK]. 
5.Press Add to open the Macro Editor. 
6.Tick the Dropdown Button 
7.Select Mode: USB 
8.Press OK. 
 
Now we need to set the frequency to 14.070.000: 
 
9.Press Add again to open Macro Editor 
10.Tick the Frequency button  
11. Enter [14.070.000 MHz]. 
12.Press OK. Your definition now contains two entries:  
13.Press Save, this returns you to the Macros Manager. 
14.Press OK and the Macro Editor closes. 
 
You now have two sub-folders of macros displayed in the Selection window. You can 
create more to match your operating needs. 
 
SnapshotsThe 
snapshot 
button creates 
a definition 
that contains 
the state of all 
input fields. 
This is an easy 
way of 
preserving a 
known state of 
your radio once 
you have set it 
up exactly the 
way you want. 
You can add 
functions as 
you did pre- 
viously to 
further 
enhance your 
snapshot. 
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Your snapshots will be found in their own 
sub-folder of macros. 

 
 
 
 
 
 

 

 

Mens 
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Chapter 9 

 

Introduction 

In the previous chapters we explored the layout as delivered. We did do some small acts of 
customization. We will now explore most of the items that can be changed, modified, or even 
removed. The final layout is up to the user to define. Just because it is delivered as the default 
view, it may not be what you want or desire. Before you start making wholesale changes, make 
sure that you have your radio connected and working. 

There are, as usual, several ways to navigate to the Customize Layout dialog win- dow which is 
used to define the appearance of the radio display. Your choices are: 

 

From the menu bar select Tools. Near the bottom of the selection box, click on Customize 
Layout. 

 
Press Ctrl+F8 keys. 

Press the   Customize button on the tool bar. 
 

Customize Layout 
 
There are, as usual, several ways to navigate to the Customize Layout dialog win- dow which is 
used to define the appearance of the radio display. Your choices are: 

● From the menu bar select Tools. Near the bottom of 
the selection box, click on Customize Layout. 

● Press Ctrl+F8 keys. 
● Press the   Customize button on the tool bar. 
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Schemes 
 

 
 

The first tab on the display is "Schemes".  Schemes are predefined customizations created by 
the Ham Radio Deluxe creative team and other Ham Radio Deluxe users.  There are four 
different schemes shipped with Ham Radio Deluxe.  Scheme #1 - #3 and the System Default.  
You can not change the look of the default schemes. 
 
You can add or modify schemes displayed in the large Schemes list.  The Ham Radio Deluxe 
team and HRD users have already created the schemes that are there.  Special thanks to 
Danielle in Northeastern, UK for his contributions. 

• Select a default scheme by pressing the scheme button (or select an entry and 
press Select); 

• Select one of the other schemes by double-clicking on the entry in the 
Schemes list. 

 
If you have modified a layout scheme and wish to save it with a new name, press "SAVE" and  you will 
be prompted for a Scheme name.  Use "Rename" and "Delete" to organize the available schemes. 
 
If you need to save the file to a location different than the default location, press the "SAVE AS  FILE" 
button.  This allows you to save your options file to any location. 

 

If you receive a options file from someone else, you can add it to your copy of Ham Radio Deluxe by 
pressing the Load from File button and navigating to the options file location and selecting the file. 
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 Layout 
 

 
 

The next tab is the Layout tab. This is where we can modify the screen layout for our buttons and 
drop downs. This is one place where personal preference will cause you to pull your hair out because 
things are not where YOU want them. Re mapping the layout is really quite easy. 
 
Ham Radio Deluxe is a data-driven program. For each radio there is a table of supported commands 
and associated button / drop down / slider names. The lay- out order is more-or-less alphabetical. 
Don't be put off by the amount of informa- tion in this window – take it slowly and read the 
information here. 
Note: The layout definition is saved on a per-radio basis in the registry. For your sanity 
only have a connection open to the radio that you plan to modify the layout. Close any 
other radio connections. 
 

 

<-- This small portion of the dialog allows us to do 
amazing things. 
Clear Entry 
If we click on a button above the area such as the VFO A 
button, we can clear the button so we can use the location 
for some other function. This is done by clicking the Clear 
button. We can also remove an entry by dragging it into the 
Unassigned list on the right side of the dialog box. 
Moving Entries 
We can move the selected entry by simply dragging it with the mou  
or by using the four arrow-buttons. 
 
Dropdown Button / CAT Command / Macros 
You can create new buttons - for example, to create a USB button f  
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the Mode dropdown: 

9 Open the Customize Layout dialog a  
click on the Layout tab. 
10 Select or create an empty 
button position – the selected entry will start to blink (you can 
reposition this button later), 
11 In the Define Button area of the dialo  
press Select (above the Save and 
Load buttons), This will open the Configure Button dialog. 
12 In the Configure Button dialog 
window select Mode: LSB and enter the text to appear on the new 
button. 
13 Press OK. 
 

 
 

14 Press Apply in the lower left corner o   
current screen. 
15 The previously empty button position  
has a new value – LSB! 
16 If you had previously created a ma  
or created a custom CAT command, you would have had the choice  
applying one of them to your button. We will cover macros and CA  
commands later in this manual. 

 
 

Hiding Dropdowns 

 

 



HRD Rig Control V6.3          Copyright © 2016 HRD Software LLC         

 

126 

 

Dropdowns 

 

Select the dropdown menu, and then simply drag an 
entry to an unused location in the display. 

If you drag to a location that already has a defini tion 
the current definition is removed, if a standard button 
it is returned to the unassigned list. 

 

Unassigned 
Entries in the Unassigned list are standard but- tons that are not currently displayed. Simply drag 
an entry to an unused location in the dis- play. 

If you drag to a location that already has a definition the current definition is removed, if a 
standard button it is returned to the Unassigned list. 

 

Styles 

 

In the Buttons tab you can define up to seven button 
styles, shown here in the Button Styles group. The 
Buttons tab is the next tab we will visit. 

To assign a style to a button either: 

•Drag the style over the button, or 
•Click a style to apply it to the currently selected 
(blinking) button. 
 

 
 

Save/Load 
 

 

To distribute your layouts with other urs of your radio model  
the Save and Load buttons. You can also clear the deck and st  
over fresh or revert back to the default button layout. 
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Buttons 
 

 
 

The above screen allows you to customize the buttons on the display. 

 Seven button color combinations, 
• The font, and 
• The button size. 

The default button size is small; this is so that users with low resolutions such as 800 x 600 still 
have a usable configuration. There are no rules when using the but- ton size; select the size which 
pleases you most. 
For the technical readers the button size is tied to the font size of the radio display 
form (font is 
Microsoft Sans Serif, size is 8, 9, 10 or 12 point). 

Changing the font size simply changes the font assigned to the form. 

The button size can also be changed by selecting View on the menu bar and then 
selecting Layout Size. You can also [right click] on any button on your display and 
select Layout Size. 
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Faceplate 

 

Background 
These colors are applied to the background area of the display and to the transmit meters (if any) 
such as PWR, SWR and ALC. 

Status Window 
The status window displays information which you cannot normally change using buttons or 
sliders in Ham Radio Deluxe. 

Typical examples are Scanning status, Split mode and Memory channels. 

Clock Position 
The clock is displayed to the left, right or both sides of the band title. 
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Frequency Display 
 

 
 

If your radio supports simultaneous access to two VFO's (Kenwood, some Yaesu) then Ham Radio 
Deluxe will display two VFO's, otherwise just one VFO is dis- played. 

First select the VFO you are updating – main or sub. The colors you can set are: 

• Background, 
• Frequency – the digits, 
• Active Posn – the bar above and below the current digit, 
• Inactive Posn – the bar above and below the other digit. Default 

is the same as the background color. 
The Font can also be set, use the Main > Sub and Sub > Main buttons to copy settings between 
VFO's. 

Dropdowns 
The dropdown buttons (Mode, Filter...) can be displayed at the top of the main frequency display. 

Select: 

• None (no dropdowns), 
• Mode (only the mode dropdown) or 
• All (all dropdowns). 

If Mode or All is selected you can check Add Border to add a border around the text. 

If All is selected you can check Include Title to add the Dropdown button's title (if there is room). 
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Customize Meters 

 

The Background and Text colors should be obvious. There are three graduation colors: 

• Bars: Low – the first bar color, 
• Bars: High – the color at the position set by the High Position 

slider, and 
• Bars: Free – the color for the free (empty) bars. 

If you check Show peak reading the recent peak value is displayed. 

When Ham Radio Deluxe is in TX mode the S Meter value is replaced by the value 
selected in the Main and Sub dropdowns, the value you select must be dis- played by 
Ham Radio Deluxe in the upper right hand corner of the display. For Kenwood radios 
the value to be displayed is selected with the meter slider or the individual buttons 
(SWR / Comp / ALC / dB). 

If you check the Always update... option then the S Meter is updated when you 
change frequency – this results in slower performance. 
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Slider Appearance 

 
 
If supported by your radio, sliders are displayed at the bottom of the display. Here you define the 
appearance of the sliders. These colors are optionally applied to the sliders in the Advanced 
selection windows (select Advanced from the View menu). 
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Slider Layouts 
 

 
 

Here you select the sliders to be displayed. Define up to six layouts, for example one 
layout for SSB and another for CW. 

Tuning Dial 

 
Here you define the colors, fonts and band button positions. 
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Chapter 10 

 

Introduction To Remote Servers 
 
A popular feature found in Ham Radio Deluxe that is not found in many other ham radio software 
packages is the ability to operate your station via HRD's built- in remote server software. 
There are places, however, where you may not be able to operate your base system from remote. 
These places are, for example, your work environment where the computers you use are behind a 
firewall or router that are not under your direct control. Certain ports need to be available through 
the firewall and routers in order for you to connect remotely to your base station and these may be 
blocked in a corporate environment due to various reasons.Ham Radio Deluxe is evolving into a 
program that supports all the serial port-enabled devices that you control at your remote station. 
 
There are two Remote Servers built into the HRD software. For radio control you use the Ham Radio 
Deluxe Remote Server. For other devices such as keyers and rotators you use the Ham Radio Deluxe 
Serial Port server. (See the chapter on HRD Remote Serial Port Server) 
 
This chapter deals only with the Rig Control Server. 
 
Note that the Ham Radio Deluxe Remote Server is highly optimized for use with Ham Radio Deluxe 
and should be used to control the radio. 
 
Note: The process of setting up these remote servers is not something an inexperienced 

computer user should attempt. Find a friend who makes his living setting up and 
maintaining computer networks. Be kind to them and reward them so they will come 

again and help when something stops working. 
 

 

HRD Remote Vocabulary 

 
While setting up the HRD Remote server, you may run into many terms used that you have 
heard but are not exactly familiar with.  We'll go over many of these terms and explain what 
they mean and how they are used in conjunction with the HRD Remote Server.  If you ever 
need to contact HRD support, knowledge of the terms used will help you describe an issue to 
the technician and will also help you understand the technicians responses. 
 
Below are brief definitions of some of the vocabulary words we'll be working with when 
discussing the HRD Remote Server installation and operation. 
 
● Host - This is the computer that is physically connected to the radio equipment in your ham 
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shack.  This is also the only computer which runs the HRD Remote Server. 
● Remote - The laptop or other computer used to connect to the Host system from a remote 

location.  This computer is not physically connected to any equipment in your shack. 
● localhost - Or IP Address 127.0.0.1 is the loopback Internet protocol (IP) address also 

referred to as the "localhost." The address is used to establish an IP connection to the same 
machine or computer being used by the end-user.  

● LAN - A local area network (LAN) is a computer network that interconnects computers 
within a limited area such as a residence, school, laboratory, university campus or office 
building and has its network equipment and interconnects locally managed.  

● IP Address - An Internet Protocol address is a numerical label assigned to each device 
(e.g., computer, printer) participating in a computer network that uses the Internet 
Protocol for communication.  An IP address serves two principal functions: host or 
network interface identification and location addressing. Its role has been characterized as 
follows: "A name indicates what we seek. An address indicates where it is. A route 
indicates how to get there."   

● Port Forwarding - In computer networking, port forwarding or port mapping is an 
application of network address translator (NAT) that redirects a communication request 
from one address and port number combination to another while the packets are 
traversing a network gateway, such as a router or firewall. This technique is most 
commonly used to make services on a host residing on a protected or masqueraded 
(internal) network available to hosts on the opposite side of the gateway (external 
network), by remapping the destination IP address and port number of the 
communication to an internal host. 

● External IP Address - If you are planning on connecting to your system via the internet 
from outside your home network you are going to have to know the exact internet IP 
Address of the computer you are connecting to. This connection must be a full time 
connection. ISPs assign a Dynamic IP Address to your computer system. For example, 
your dynamic IP address may be 68.74.165.227. This would be the address you would use 
to connect from your remote computer to your base system over the internet. The problem 
comes in when most ISPs change that address from time to time without you knowing it. 
Some change the IP address at random times, others change your IP address each time 
you disconnect and reconnect your modem to the internet while others change your IP 
address each day. There are two solutions to this problem. The first is to contact your ISP 
and request a STATIC IP address for the system where the remote server is running, (your 
shack computer). This is usually inexpensive, around $5.00 or so a month added to your 
internet bill. The second solution would be to use a service such as NO-IP, DYNDNS or any 
one of many such services which provide a free solution to the problem of not having a 
static IP address. These services monitor your IP address and track any changes while 
providing you with a constant connection through their DNS servers so any change in your 
IP address will not effect the address you use to connect to your remote system. If you are 
installing on a remote computer then the computer must have a static (non-changing) 
public IP address. If you have a public IP address which is not static then visit 
http://www.no-ip.com/ and use the free IP redirection option. 

● Internal IP Address - There is another IP address that also requires attention if you plan 
to run the HRD Remote server on a computer in your shack. If you have only one 
computer in your shack and it is connected directly to the internet via a modem there isn't 



HRD Rig Control V6.3          Copyright © 2016 HRD Software LLC         

 

135 

 

much problem. A problem arises if you have more than one computer in your house and 
they each connect to the internet through a router, wireless or hard wired. When 
connected to the internet via a router, each computer connected to the router has it's own 
INTERNAL IP Address. Just like with your Internet IP address, this internal IP address 
can change depending on the sequence the differ- ent computers are booted up and access 
the router. It is advised you set an internal STATIC IP address for the computer running 
HRD's Remote Server software. You will find instructions to do this in the next section of 
this documentation. 

● Firewall - You have probably heard this word and know what it is.  You may possibly have 
more than one on your computer system and not know it.  You are probably familiar with 
your Windows firewall or one within your Anti-Virus software, however, you may also 
have one in your router or modem.  You need to check for both and make sure you open up 
ports 7805 (Ham Radio Deluxe Remote Server) and 7806 (Ham Radio Deluxe Serial Port 
server) for incoming TCP traffic. 

 

How Remote Servers Work 
 

 
 

In this example the remote station uses serial ports as follows: 
• COM1 --> IC-7800, 
• COM4 --> WinKey keyer, 
• COM6 --> AlfaSpid rotator. 
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Your VCP software needs to be able to create two virtual null modem "cables".  
 
In this example the "cables" map ports as follows: 
• COM20 <-> COM21, and 
• COM22 <-> COM23 
 
The local station connects as follows: IC-7800 
Remote port selected, TCP/IP connection made with the Ham Radio Deluxe Remote Server 
running on the remote computer (port 7805). The Ham Radio Deluxe Remote Server connects 
to the IC-7800 using COM1. 
 
Keyer 
The Ham Radio Deluxe Winkey interface connects to the Ham Radio Deluxe Serial Port client 
on the local computer using the COM20 <-> COM21 virtual cable.  The Ham Radio Deluxe 
Serial Port client connects to the Ham Radio Deluxe Serial Port server on the remote computer 
using TCP/IP (port 7806). 
The Ham Radio Deluxe Serial Port server connects to the K1EL WinKey using COM4. 
 
Rotator 
The Ham Radio Deluxe Rotator interface connects to the Ham Radio Deluxe Serial Port client 
on the local computer using the COM22 < - > COM23 virtual cable.  The Ham Radio Deluxe 
Serial Port client connects to the Ham Radio Deluxe Serial Port server on the remote computer 
using TCP/IP (port 7806). 
The Ham Radio Deluxe Serial Port server connects to the AlfaSpid rotator using COM6. 

Setting Up A Local Static IP 

 
It is very important to setup a static ip address for your computer if you are going to use port 
forwarding. When you have port forwarding setup, your router forwards ports to an IP address 
that you specify. This will probably work when you initially set it up, but after restarting your 
computer it may get a different IP address. When this happens the ports will no longer be 
forwarded to your computer's IP address. So the port forwarding configuration will not work. 
 

What is an IP Address? 
IP addresses are four sets of numbers separated by periods that allow computers to identify 
each other. Every computer has at least one ip address, and two computers should never have 
the same ip address. If they do, neither of them will be able to connect to the internet. 
 

Dynamic vs Static IPs 
Most routers assign dynamic IP addresses by default. They do this because dynamic ip address 
networks require no configuration. The end user can simply plug their computer in, and their 
network will work. When IP addresses are assigned dynamically, the router is the one that 
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assigns them. Every time a computer reboots it asks the router for an IP address. The router 
then hands it an  IP address that has not already been handed out to another computer. This is 
import- ant to note. When you set your computer to a static IP address, the router does not 
know that a computer is using that ip address. So the very same IP address may be handed to 
another computer later, and that will prevent both computers from connecting to the internet. 
So when you assign a static IP addresses, it's important to assign an IP address that will not be 
handed out to other computers by the dynamic IP address server. The dynamic IP address 
server is generally referred to as the DHCP server. 
 
All Windows versions, Vista to Windows 10, are very similar when it comes to these steps.  If 
you can, print out these pages of instructions as you will have difficulty viewing them on-line 
while you preform the configuration tasks. 
 
1.  Open up the start menu, and look for the Search programs and files box. 
2. Type CMD in the Search programs and files box, and press Enter on your keyboard. This 
will bring up a black command prompt window. 
 
There are alternate ways of getting to the "CMD" prompt window, depending on your Windows 
version.  You can click the "Windows Key +R" to open the "Run" dialog and type "CMD" in the 
run box, or in Windows 10, you can right-click on the "Start" button and select "Command 
Prompt" or "Command Prompt (Admin)" from the menu option. 
  
3. The command prompt may look different on your screen, but it doesn't really matter. Type 
ipconfig/all at the prompt in the command window, and then press the enter key. This will 
display a lot of information. If it scrolls off the top you may need to enlarge the window. 
 

 
 
  
4. Record the following information: 
  
IP Address: ____.____.____.____ 
 
IP address Subnet Mask: ____.____.____.____ 
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Default Gateway:  ____.____.____.____ 
 
DNS Servers: ____.____.____.____ 
                          ____.____.____.____ 
                          ____.____.____.____ 
  
You may not have three DNS Servers. Just leave the unused blank. We are only concerned with 
IPv4 entries, you can ignore the IPv6 stuff. 
  
The name server entries are a bit complicated. Name Server is just another name for DNS 
(domain name server). Some router's act as a proxy between the actual name servers and your 
computer. You will know when this is the case, because the Default Gateway will list the same 
ip address as the Name Servers entry. 
 
We need to have the correct Name Server IP addresses. If we do not, you will not be able to 
browse the web. There are a couple ways to get these. The first way is to log into your router's 
web interface, and look at your router's status page. On that page you should see an entry for 
DNS Servers, or Name Servers. Write down the ip addresses of your Name Servers. 
 
Another way to get the correct Name Servers to use, is to give your ISP a call. They should 
know the IP addresses of your Name Servers right off. If they ask you why you need them, you 
can tell them you are trying to setup a static IP address on your computer. 
 
5. Type exit in this window, then press the enter key to close it. 
6. Once again open the start menu. This time click Control Panel. 

7. Click on Network and Sharing Center. 

8. Single click Change adapter settings on the left side of your screen. 

 
9. You might have more than one Internet connection listed here. You will need to determine 
which adapter is your connection to the Internet if this is the case. If you have a choice of a 
wired or wireless connection, choose the wired connection. 
 
10. You can either right click or double click on your network adapter and choose properties to 
open up the properties window of this internet connection. 
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 11. Click on Internet Protocol Version 4(TCP/IPv4) and then the Properties 
button. 
  

 
 
 12. You will see the following screen: 
 

 
  
13. Before you make any changes, write down the settings that you see on this page. If 
something goes wrong you can always change the settings back to what they were! You should 
see a dot in the Obtain an IP address automatically box. If you do not, your connection is 
already setup for a static IP. Just close all these windows and you are done. 
  
 
Pick an IP address and enter it into the IP Address box. The IP address you choose should be 
very similar to the router's IP address. Only the last number of the ip address should be 
different. If the router's IP address is 192.168.1.1, I might choose 192.168.1.10. The IP address 
you choose should end with a number between 1 and 254, and should not be the same as the 
router's IP address. Every device that connects to your network needs to have it's own IP 
address. 
 
Put the subnet mask we previously found in the subnet mask section. The default gateway 
should go into the Default gateway box. Enter the DNS Servers we previously found into the 
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two DNS Server boxes. Click okay all the way out of this menu. 
 
If you find that you can not pull up web pages, the problem is most likely the DNS numbers you 
entered. Give your ISP a call, and they will be able to tell you which DNS servers to use. 
That's it you should be done! If you can't connect to the internet go back and change your 
configuration back to what it originally was. 

Installing The Servers 
 
To install the service select Remote Service from the Tools> Programs menu. 
  

 
 

● Press Ham Radio Deluxe Remote Server to select this server. 
● Press Install to install the service, and then press Start to start the 

service. 
You can start the Windows Services applet (Start > Settings > Control Panel > Administrative 
Tools > Services) to modify the properties of the service, for example disabling automatic startup. 
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NOTE:  You need to make certain you open your FIREWALL and put in a rule to allow incoming connections on Port 
7805.  If this is not done, it's likely when you attempt to connect to from remote, the connection will fail. 

Configuring The Remote Server 
 
We are now ready to configure the Remote Server.  Press the "Configure" button on the Remote 
Server panel.  The configuration file will open in a Notepad window.  The items needing 
configuration are highlighted in the configuration file below.   
 
Each user who accesses the system must have a username and password.   
 
A pound sigh (#) as the first character of a line indicates the line is a comment and the # must 
be removed from the line before it is recognized by the software. 
 
# 
#   Ham Radio Deluxe Remote Access Server 
#   ------------------------------------- 
#   Copright (c) 2011-2013 HRD Software LLC 
# 
#   Note: Remote Server Runs on Windows XP/SP3, Windows7 and Windows 8 
#    
#   This file defines the configuration of the Remote Access Server. 
#   The format of each entry is TOKEN = VALUE.  
# 
# 
#   Supported tokens 
#   ---------------- 
#   COM 
#   PORT 
#   USER1 to USER20 
#   WELCOME 
# 
 
# 
#   A comma-separated list of COM ports that are returned. If not defined then 
#   the server returns a list of all COM ports available on the computer. 
# 
#COM = COM1,COM2,COM3,COM4 
#COM = COM3 
 
# 
#   The TCP/IP port on which the server listens for connections. If not defined 
#   then the default value of 7805 is used. Select any port number you want which 
#   is not in use by other programs. 
# 
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PORT = 7805 
 
# 
#   Username/passwords, these are case-insensitive. Spaces are removed 
#   from the beginning and end of the username and password. 
# 
#   The format is USERx = username,password 
# 
USER1  = Simon,SnowTime,restart 
USER2  = Peter,Uberwald 
USER20 = Donald,California 
 
# 
#   Welcome text, displayed on the remote user's computer. Note that 
#   \n is replaced with a newline. Enter up to 511 characters on a single line. 
#   This message may be changed to anything you want, as long as you keep  
#   the current format with the "\n" used to indicate a new line. 
# 
WELCOME = Welcome to the HRD Remote Access Server.\n\nPlease don't break 
anything! 
 
The contents of this file should be obvious. After changing the configuration, save the changes 
and you should restart the service. 
 
Restricting TX 
One special note – to restrict a user's ability to switch the radio to transmit there are now 
optional tokens added with the username and password to disable access to the TX and any 
Tune buttons.  Add no_tx after the password. 
 
In addition you will want to disable macros as a knowledgeable user can define a CAT 
command to enable TX. Add no_macros after the password. 
 
 
Enable Restart 
The RESTART token enables the Restart button on the connection window. Restarting the 
service will close all COM ports opened by the service and drop all connections by Ham Radio 
Deluxe users.  This should only be allocated to yourself and your friends! 
  

Connecting to the Remote Server 
 
Connecting to the host computer from remote is almost like connecting to the radio while on 
the base computer system. 
If you don't already have it done, you will need to 
1. Install Ham Radio Deluxe, if you have not done so, on the computer you plan to use for the 
remote connection. 
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2. Once installed, run Ham Radio Deluxe. 
3.When the Rig Connection screen appears, you will need to set this up EXACTLY as it appears 
on your HOST system, with ONE exception. Instead of entering a comport number you select 
REMOTE from the drop down box as indicated by the red arrow in the image below. 
 

 
  
4. Press Connect and the Remote Connection window will display. 
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5. In the New Connection area of this window enter the internet IP address or the domain 
name of the HOST computer.  If you are working from inside your home through a router, 
enter the internal IP address of computer physically connected to the to the radio equipment.  
This address will look something like 192.168.x.x.  The port is the default port of 7805. 
 
6. Now you enter a valid user name and password that was configured in the Rig Control 
Configuration file. You can check the Save Settings box so next time you connect you just select 
the connection from the list on the left side of the display. The user name and password are not 
case sensitive. 
7. To save these values make sure the Save settings option is checked [X]. 
8. Press the Connect button. The display will change showing the Com Ports in the lower right 
half of the screen. 
9. Select the com port from the drop down box that connects to the radio at the HOST location. 
You can also uncheck the box for the optional PTT com port. 
10. Press the OK button at the bottom of the window and the next screen you see should be the 
rig display from the remote server. 
At this point if you have problems connecting to the host machine, you need to double check all 
your settings. Check to make sure the firewall or router are not blocking the ports required. If 
you are still having problems and can't find the answer, feel free to contact HRD Customer 
support for help. 
 

 Load connection information from a file. 
 Save connection information to a file. 
 Press Connect. 

  
If the connection is successful you will see the confirmation window and the text Username / 
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password authenticated. Select a remote COM port, then press 'OK' is displayed below the 
Connect button. 
 

 
  
Now select the COM port, and then press OK to connect to the remote COM port and start the 
Ham Radio Deluxe radio display. 
 
When the connection with the radio has been confirmed a Remote Connection display window 
shows you the data throughput and average round-trip time. 
  

 
 

Remote Connection 

 
  
Use the Remote Connection window to show the status of the remote connection. 
• Round-trip time: the time required to send a message from Ham Radio Deluxe to the remote 
server and get a response. This will be very similar to the value shown when you use Ping to 
interrogate a remote host. Typically values of 50 milliseconds or less are very usable. 
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• Refresh interval: the interval between refreshes of the selected Regularly Read options. 
• Send frequency: when the frequency is updated over a link with a high round trip time (> 
100ms) the performance will be less than optimal with Sync selected so if the round trip is high 
select Async, otherwise just select Sync. The disadvantage of using Async is an 'elastic band' 
effect while tuning by dragging Ham Radio Deluxe's small tuning marker. 
• Regularly Read: the options that are regularly updated. If you are using a fast link - for 
example to a local station with a low round- trip time then you can safely select all options. The 
disadvantage of selecting options such as Buttons, Dropdowns, Sliders and Status Texts is that 
it may take a second or two before Ham Radio Deluxe detects that you are changing the 
frequency by dragging the tuning marker and the current refresh operation cannot be 
interrupted. 
 

Slow Link 
 If you have a slow link - a round-trip time > 100 ms - then select only Meters. As this is a 
remote station it is unlikely that anyone else will be adjusting the radio's controls so you will 
not need to refresh buttons and dropdowns as you would with a locally connected radio. 
 
The disadvantage of not selecting Buttons and Dropdowns is that inter-button dependencies 
will not be shown - for example you may have 4 AGC buttons Off, Fast, Medium and Slow, only 
one of which will be active at any one time. If Buttons is not enabled for regular refreshes then 
pressing Fast will not update the other AGC buttons. In this case you must press the small 
refresh button to the right of the Buttons check box. 
 
To refresh all display options click Refresh All. 
  

Problem Solving 
The following steps are recommended to solve problems using the remote server. 
1. Run Ham Radio Deluxe on the remote computer to check that you can actually connect to 
your radio. 
2. When you connect to the remote server make sure you have closed Ham Radio Deluxe on the 
remote computer. If you get the error "Access is Denied" then the COM port is held open by 
another program. 

Remote Audio 
 
One thing to keep in mind when using Remote Audio.  You are using VOIP (Voice Over IP) and 
sometimes the quality is not as good and there is usually some delay between the remote 
computer and the host. 
 
After the completing of the rig control portion of a remote station you will need to setup the 
ability to pass audio to and from the remote station. If you are only working the digital modes 
like PSK31 you will not need to worry about this. CW has been discussed previously in this 
chapter. 
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Skype has been a traditional method of passing audio in both directions.  This requires having 
TWO Skype accounts, one for the Host and one for the Remote.  On the Host machine, Skype is 
configured to pull the audio from the radio and send it over the internet.  On the Remote 
computer, Skype is configured to receive the audio from the internet and play it through the 
computer's soundcard and speakers. 
 
Another option for remote audio is a small remote audio Server and Client called RemAud.  
RemAud is a FREEWARE Voice over IP (VOIP) application primarily designed for two-way 
amateur radio remote control over the Internet. RemAud uses streaming-audio technology in a 
client–server architecture. It features high radio sound quality, low latency, low bandwidth and 
very low CPU usage. RemAud uses the TCP protocol for an easy installation behind routers and 
firewalls.  You can get more information and download the software from:  
http://df3cb.com/remaud/ 
 
A new option was added to Digital Master 780 in Ham Radio Deluxe Version 6.2. This option 
brings us one step closer to being able to provide fully integrated audio within the Ham Radio 
Deluxe suite of programs for remote operation, without having to rely on 3rd party software 
such as Skype.  This option allows the user to operate voice communications using a standard, 
inexpensive computer headset.  The "HRD Headset Monitor" is discussed in the DM-780 
manual.  The drawback to using this option is the fact that due to the many different ways of 
keying the transmitters, and the way audio is handled, this does not work on all radios.  If you 
are using an interface such as the SignaLink USB, on the Host computer, this option will 
probably work. 
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Chapter 11 

Introduction To Serial Port Server 
The Ham Radio Deluxe Serial Port Server enables a connection between Ham Radio Deluxe 
and serial port-enabled devices (keyers, rotators) connected to a remote computer that can be 
contacted via TCP/IP. 
 
IMPORTANT:  If you plan on using the HRD Serial Port Server you are going to need some 
additional software in the way of a program that creates Virtual Com/Serial ports (VCP 
software) or Virtual Null Modem Cables.  HRD use to supply the N8VP software, however that 
is no longer available.  That software only worked with Windows XP and to our knowledge has 
never been developed any further.  There are some freeware offerings available and many 
commercial offerings.  The choice is up to each operator. 
 
 

Note: The process of setting up these remote servers is not something an 
inexperienced computer user should attempt. Find a friend who makes his living 

setting up and maintaining computer networks. Be kind to them and reward 
them so they will come again and help when something stops working. 

 
 
The Ham Radio Deluxe Serial Port files are: 
• Ham Radio DeluxeSerialPortSvr.exe – the executable, and 
• Ham Radio DeluxeSerialPortSvr.cfg – configuration file. 
 
To install the service select Remote Service from the Tools> Programs menu. 
 

 
 
1. Press Ham Radio Deluxe Serial Port Server to select this server. 
2. Press Install to install the service. 
3. Press Start to start the service. 
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You can start the Windows Services applet (Start > 
Settings > Control Panel > Administrative Tools > 
Services) to modify the properties of the service, for 
example disabling automatic startup. 
 

 
 

Configuring The Serial Port Server 
 
Prior to configuring the server you must open the firewall and add an exception to allow 
communications through Port 7806.  Once the port is opened through the firewall, Press 
"Configure" to edit Ham Radio DeluxeSerialPortSvr.cfg that contains the service configuration. 
 

Configuration File 
To configure the Serial Port Server, you need to edit the highlighted options in the 
configuration file to refer to ports and logins for your own system. Remember, the pound sign 
(#) at the beginning of a line indicates that line is just a comment.  It MUST be deleted from 
lines for the COM Ports you assign. 
 
 
# 
#   Ham Radio Deluxe Serial Port Server 
#   ----------------------------------- 
# 
#   Copyright (c) 2006 by HRD Software LLC 
# 
#   Note: this only runs on Windows Vista/8/8/8.1/10. It does not run 
#   on Windows 95/98/ME/SE/XP. 
# 
#   This file defines the configuration of the Remote Access Server. 
#   The format of each entry is TOKEN = VALUE.  
# 
#   Supported tokens 
#   ---------------- 
#   COM 
#   PORT 
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#   USER1 to USER20 
#   WELCOME 
# 
 
# 
#   A comma-separated list of COM ports that are returned. If not defined then 
#   the server returns a list of all COM ports available on the computer. 
# 
#COM = COM1,COM2,COM3,COM4 
#COM = COM1 
 
# 
#   The TCP/IP port on which the server listens for connections. If not defined 
#   then the default value of 7806 is used. Select any port number you want which 
#   is not in use by other programs. 
# 
PORT = 7806 
 
# 
#   Username/passwords, these are case-insensitive. Spaces are removed 
#   from the beginning and end of the username and password. 
# 
#   The format is USERx = username,password,options where options is a 
#   list of case-insensitive tokens seperated by spaces (not commas). 
# 
#   The supported options are: 
#       RESTART 
# 
#   RESTART allows the user to restart the service, usually reserve this for only 
#   for yourself and friends you trust! 
# 
USER1  = Simon,SnowTime,restart 
USER2  = Peter,Uberwald 
USER20 = Donald,California 
 
# 
#   Optional welcome text, displayed on the remote user's computer. Note that 
#   \n is replaced with a newline. Enter up to 511 characters on a single line. 
# 
#   Remove this line if you do not want a welcome message. 
# 
WELCOME = Welcome to the HRD Serial Port Server.\n\nPlease don't break anything! 
 
Once you have the configuration file edited for the settings in your system, save the file and you 
start the Remote Serial Server.  You can now load and configure the Serial Port Client (see 
Serial Port Client in Chapter 6) on your Remote computer. 
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